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Product SAEAUT SNMP OPC Server™ is a gateway between
SNMP devices and applications with OPC client.

It consists of:

- runtime application - for communication and data processing,

- configuration application - for configuring of OPC server address
space and data preprocessing.
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1 Introducing SAEAUT SNMP OPC Server

Product SAEAUT SNMP OPC Server™ consists of two main applications for Windows operating
systems - configurator (with user interface) and runtime application (without user interface) plus a
few help applications and software modules. Itis sold in three modifications - BASIC, ENHANCED
and PROFESSIONAL.

SAEAUT SNMP OPC Server™ is supposed to be used with customer's OPC client applications.
However, to gain experience with OPC client usage, some ready made OPC client applications are
delivered within SAEAUT SNMP OPC Server™ . There are also source codes for some OPC clients
that can be used as templates by development own OPC clients.

The configurator enables to configure address space (sometimes called namespace) and ways of data
processing for the runtime application - the SNMP OPC server itself.

Runtime application is used as a communication gateway between SNMP and OPC
communication protocols. Some interfaces (OPC DA, AE custom) are provided by the runtime
application and some using wrappers (OPC DA automation, OPC XML DA, OPC UA).

There is also application (SAEAUT Web View) enabling reading /writing data using web browser.

Configurator itself contains OPC DA client (Monitor view) that can be used for debugging of integrated
applications with SAEAUT SNMP OPC Server™ as well as a few productivity tools enabling fast
configuring of big amounts of communication data points. Configuration is mostly saved to mdb
database file.

Copyright © 2004-2013, SAE - Automation, s.r.o. (Ltd.), All rights reserved.
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Figure: SAEAUT SNMP OPC Server - configurator, runtime application, wrappers, interfaces,
functionality overview

SAEAUT SNMP OPC Server™ usage:

¢ Integration of monitoring and control of network communication infrastructure and other devices

using the SNMP protocol with monitoring and control systems, SCADA and other applications using

OPC interfaces.

Alarming of devices communicating by SNMP protocol using OPC AE (UA) standard.

Monitoring and control of devices with running SNMP agent.

Monitoring and evaluation of the availability of unmanaged devices (without SNMP agent).

Identification of devices using IP protocol in communication networks.

Creating custom applications in JScript to communicate with devices using the SNMP protocol:

¢ Recalculation of MIB variables by reading and writing them from / to devices using functions
written in JScript

e Calculation of induced variables, based on MIB variables from devices and other variables and
objects provided by JScript engine

e Store data in databases

e Sending e-mails

e Creating custom OPC servers

o Import of MIB variables from devices connected to manageable devices (with the SNMP agent) and

Copyright © 2004-2013, SAE - Automation, s.r.o. (Ltd.), All rights reserved.
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automatic configuration of address space of the OPC server
¢ Import of MIB variables from the MIB files to the address space of the OPC server
o Export and import directories from / into the address space of the OPC server from / to CSV files
¢ Providing access to the OPC server address space over Internet/intranet

1.1 How to buy SAEAUT SNMP OPC Server

You can place your order online, by fax /e-mail or by phone (+421 42 4450701). Online orders are
processed immediately and therefore more quickly than other methods. It is the preferred method of
ordering.

The modification of the SAEAUT SNMP OPC Server™ can be chosen according to the following
features table.

Copyright © 2004-2013, SAE - Automation, s.r.o. (Ltd.), All rights reserved.
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SAEAUT SNMP OPC Server

SNMPv2c, SNMPv1

OPC DA 3.0, 2.05, 1.0

OPC AE 1.10 (Alarm management)
OPC UA 1.01 wrapper

OPC XML DA 1.01 wrapper
Configuration tool

Monitoring OPC client in configuration
tool
Max. number of connected devices

MIB Browser (On-line)

MIB Browser (Off-line)

SNMP GET/SET operations can be
called from the configuration tool
JScripts - possibility to use scripting

IP Scanner

Logging of runtime functionality to file
Find tool

SAEAUT SNMP Agent

SAEAUT SNMP OPC Client

OPC Client examples with source code
Import from CSV file

Export device data to CSV file

Installing as Windows NT Service
With SAEAUT OPC WebView

Basic Enhanced Pro
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nal

¥ ¥ ¥

¥ ¥ ¥
¥ ¥ ¥

» ¥ ¥

¥ ¥ ¥

¥ ¥ ¥
¥ ¥ ¥
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Buy the SAEAUT SNMP OPC Server™ modification on line:

e PROFESSIONAL
¢ ENHANCED
e BASIC
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1.2 SAEAUT SNMP OPC Server on Web

FAQ on Web

News on Web

Newest documentation in pdf format

Buy SAEAUT SNMP OPC Server in e-shop
About SAEAUT SNMP OPC Server on Web
YouTube

1.3 Usage

There are many devices that SAEAUT SNMP OPC Server™ can communicate using SNMP protocol
with. From the beginning, this protocol has been used mainly for managing of network communication
infrastructure consisting of computers,switches routers, bridges. Because of broad usage SNMP
protocol within different operating systems, clearly defined meaning of variables within standardised
and also enterprise and device specific MIB files, the creating of communication gateway for other
communication standards is very useful.

OPC standards are very much used not only in industry but also in building automation and bussines
applications. The most used standards is OPC DA. Its possibilities are complemented by OPC XML
DA (that brings possibility of web service based communication ) and the newest OPC UA standards
that (except of web services and binary communication ) brings higher interoperability and data
modeling capability.

Copyright © 2004-2013, SAE - Automation, s.r.o. (Ltd.), All rights reserved.
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Figure : Using of SAEAUT SNMP OPC Server.

Built in JScript data processing brings not only the possibility of the preprocessing of transferred data
but also possibility to integrate different not foreseen functionalities as saving of data to databases,

sending them per mail and SMS...

For management of the network equipment SNMP manager working on workstation and SNMP agent
running on network equipment are used. To be able to integrate this network management into the
various HMI or SCADA systems, which include OPC clients, it is very useful to implemented SNMP
manager into the application of OPC server.
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FAE - Automation
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Figure: SNMP usage for management of the network equipment.

The product is supposed to be used with custom or third party OPC client applications. OPC client
applications delivered with product should be used only to learn underlying technologies.

1.4 Features

SAEAUT SNMP OPC Server™ has following features:

implementation of protocols SNMPv1, SNMPv2c
implemented OPC specification OPC DA 3.0, 2.05, 1.0 OPC Server, OPC Alarms and Events
Version 1.10a 1.0

o from SNMP point of view, it acts as a Network Management System
e installation package is enhanced with OPC XML-DA and OPC UA wrappers, OPC DA and

OPC UA test clients,

runtime application cun run either as out of process server started by an OPC client localy or
remotely. or as Windows NT service****

the possibility to manage unlimited number of devices with running SNMP agent using one of
above mentioned SNMP protocols**

using ICMP ping (RFC 792) to manage devices without running SNMP agent, displaying of
round trip time as one OPC variable

using SNMP (RFC 1157) commands GET, SET and TRAP

processing data using JScripts* (Microsoft's dialect of the ECMAScript standard)

support of global JScript variables enabling historical data processing*

tags in address space of the OPC server are defined using MIB object identifier (Object ID), for
example .1.3.6.1.4.1.2681.1.2.102; defined Object ID's can be validated by input in OPC
configurator, data type are updated by validation process

implementation of on line MIB browser, which requests SNMP manageable device for its
SNMP variables corresponing to MIB objects and supplies user with MIB objects IDs, data types
and vaules*off **

off line MIB browser for import from MIB files

if there are some traps defined, one special thread waits for any notification from SNMP OPC
server in-built network management system (NMS)

Copyright © 2004-2013, SAE - Automation, s.r.o. (Ltd.), All rights reserved.
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Module IP Scanner, which is used for scanning computer network in defined IP area*
Event logging of SAEAUT SNMP OPC Server™ *

Examples of OPC clients

Source codes for OPC clients*

*  These modules are available only in the Enhanced version, Dasic version doesn't support them
**  Basic version has limited number (15) of the devices, which can be connected to server

*** Basic version include MIB Browser but without possibility to Adding new items

**** Only Professional

For development of own OPC client applications and reviewing of usability with third parties
applications with OPC clients it is necessary to know interfaces implemented in the SAEAUT SNMP
OPC Server™ runtime. They are listed in tables bellow.

Data Access Server Required 1.0 2.0 3.0 SAE -
Interfaces Automation
SNMP OPC
Server
OPCServer
[Unknown Reqguired Required Reqguired Supported
[OF CServer Fequired Fequired Fequired Supported
[OF CCamman AA Required Reqguired Supported
[ConnectionPointContainer AA Required Reqguired Supported
[OF CltemProperties AA Required AA Supported
[OF CBrowse MAA, MAA, FHequired Supported
[OF CServerPublicGroups Optional Optional AA AA
[OF CBrowseServerAddressSpace Optional Optional AA Supported
[OF Clteml O A4, A4, Fequired Supported
OPCGroup
[Unknown Reqguired Required Reqguired Supported
[OF Clte mbdgt Reqguired Required Reqguired Supported
[OF CGroupStatehot FHequired Fequired FHequired Supported
[OF CGroupstatehgt? AA AA Reqguired Supported
[OF CPublicGroupstatehd gt Optional Optional AA AA
[OF Caynclo Fequired Fequired Fequired Supported
[OF CSynclO? AA AA Reqguired Supported
[OF CAsynclO2 AA Required Reqguired Supported
[OF CAsynclO3 AA AA Reqguired Supported
[OF Clte mD ead bandhd gt AR AR Reqguired Supported
[OF Clte mSamplingh gt AA AA Optional Supported
[ConnectionPointContainer AA Required Reqguired Supported
[OF CAsynclO Fequired Cptional FliA, Supported
[Datalbject Reqguired Optional AA Supported

Following table summarizes the OPC Alarms and Events Serverinterfaces interfaces supported by the
SAEAUT SNMP OPC Server™ :

Copyright © 2004-2013, SAE - Automation, s.r.o. (Ltd.), All rights reserved.
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OPC Alarms and Events Server Interfaces | Version 1.0 | Version 1.10 | SAE -Automation
OPC SNMP OPC
Server

OPCEventServer

[OFP CCommon Fequired Fequired Supported

[OP CEventServer Fegquired Required Supported

[OF CEventServer Regquired Required Supported

[OP CEventServer’ M, Cptional Supported

[ConnectionFointContainer Hequired Feguired Supported

OFCEwentAreaBrowser Cptional Cptional Supported

[OP CEventAre aBrowser Optional Cptional Supported

OPCEventSubscription

[OF CEventSubscriptionhd gt Fequired Fequired Supported

[OF CEventSubscriptionh gt AR Optional Supported

[ConnectionF ointContainer Fequired Fequired Supported

1.5 System requirements

Computer/Processor Pentium Il compatible CPU
Memory: at least 128 MB (recommended 512 MB)
OS: Windows XP and higher

Already installed SNMP service

Disk space: 40 MB for full installation

In addition:

¢ if you want to use XML-DA or SAEAUT OPC Web View, then the Internet Information Services
(IIS) server is needed too. For more information please see the
How to access OPC data from Internet/Intranet through Web Service.

e For UA SDK is necessary. NET Framework 3.0, respectively. 3.5

e UA Client requires the. NET Framework 4.0, respectively. 4.5

e The source code projects require either Visual Studio 6.0 or Visual Studio .NET 2003.

Related articles
How to use access through Web Service, OPC XML-DA Wrapper

1.6 Installed software and examples

Not all parts of the product SAEAUT SNMP OPC Server™ are installed within initial installation
process. In the first step, following parts are installed:

- SNMP OPC Server - runtime application

- SNMP OPC Server - Configurator

Except of this, links to documentation and installation packages are copied and added to the start
menu of the application. From that, they can be installed in next steps. Some of them have then own
folder of the highest level in the start menu (see items SAEAUT SNMP OPC WebView and SAEAUT
UA Data Access Client in the Figure bellow). From the start menu can be opened also OPC client
example projects for MS Visual Studio.

Within the first installation step, are copied also:
- example configurations to the folder x:\Users\user\Documents\SAEAUT SNMP OPC

Copyright © 2004-2013, SAE - Automation, s.r.o. (Ltd.), All rights reserved.
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Server\Configurations\

- example MIB files to the folder x:\\Program FilesS\SAEAUT SNMP OPC Server\mibs\

- example MIB files to the folder x:\\Program FilesS\SAEAUT SNMP OPC Server\CSV

Within the first installation step, directory for log files Within the first installation
x:\Users\usern\Documents\SAEAUT_SNMP_OPC_Server\Log is created. Contrary to other directories,
this folder is not removed by uninstall process.

SAEAUT SNMP OPC Server™ is often used for monitoring and control of uninterruptible power
sources - UPS. Therefore it is delivered with example configuration SNMPConf UPS-MIB rfc1628.mdb
where MIB variables according to the rfc1628.mib are mapped to the OPC server address space.

Some OPC functionality related dll's e.g. OPCDAAuto.dll and components e.g. OPC Enum are
installed to System32 folder. There are also dlI's ReleaseTrace.dll and TraceWorX.dll that belong to
the module TraceWorX from ICONICS, Inc.

. SAEAUT SNMP OPC Server -

"% SAEAUT SNMP OPC Server Configfy

" Uninstall Created within
the first
. Help installation

| OPCClient Examples  “'®P-
. VB.NET
. VB6
. SAEAUT DA and XML DA Client
i3 Install OPC DA Client
. SAEAUT SNMP OPC WebView
1?5] Install or uninstall
& Startin browser
. SNMP Agent
™ Install SNMP Agent
. UA Wrapper -
ﬂ Install UA Wrapper
&) Start UA Wrapper (as administrt
‘3] Stop UA Wrapper (as administrjt
. XML DA Wrapper

m

. SAEAUT SNMP OPC WebView |nstalled
| SAEAUT UA Data Access Client 13tef

Figure: Start menu for SAEAUT SNMP OPC Server™

Next applications can be installed from folders of the SAEAUT SNMP OPC Server start menu (figure
above):

- SAEAUT DA and XML DA client to learn OPC DA and OPC XML DA functionality

- SAEAUT SNMP OPC WebView - to access of the OPC DA address space from a web browser

- SNMP Agent - to learn working with SNMP agents on managed devices

Copyright © 2004-2013, SAE - Automation, s.r.o. (Ltd.), All rights reserved.
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1.7

1.7.1

- UA Wrapper - by instalation of that also SAEAUT UA Data Access Client and UA configuration tool
(see in Start menu in OPC Foundation folder) are installed.
- XML DA Wrapper - to use HTTP SOAP communication

Background

In this topic you can find information about basic functionality and underlaying technologies used within
SAEAUT SNMP OPC Server™ . The topic is divided into five chapters:

e Basic fubnctionality - what enables SAEAUT SNMP OPC Server™

e OPC - this chapter describes OPC technology, it gives a briefing about the background of
OPC, about its fundamentals.

e SNMP - this chapter will bring you to the Simple Management Network Protocol (SNMP). It
describes basic definitions, basic commands of this protocol and also mapping of the values
which are stored in SNMP Agents (MIB files).

e ICMP ping

e JScript - this chapter shortly describes interpreted, object-based scripting language

Basic Functionality

SAEAUT SNMP OPC Server™ runtime application (Figure bellow) contains SNMP Manager
application using SNMP commands GET for reading and SET for writing of variables from / to SNMP
agents running on managed devices. When using SET and GET commands the communication is
initiated by SNMP manager. SNMP agents on devices can also initiate communication using SNMP
command TRAP.

Which variables have to be transferred between SAEAUT SNMP OPC Server™ and devices with
running SNMP Agents is defined within address space (namespace) of the SNMP OPC server
(address space is configured by configuration application of the SAEAUT SNMP OPC Server™ ) .
SNMP OPC server makes these variables available for applications with OPC client interfaces.
Address space can be configured as flat or as a tree structure. Tree structure of the address space
can match the tree structure of OID for MIB variables. In this case, configuring of big amounts of MIB
variables either by their mapping from connected devices or from MIB files can be very fast and
easy.

Values transferred to / from devices can be recalculated using JScript engine within SAEAUT
SNMP OPC Server™ runtime. (Within SNMP OPC server address space, also variables that have not
related mapped variables on managed devices can be defined. Values of these variables can be
affected by functionality of JScript itself.)

Variables from address space are available to applications with OPC client first of all through OPC DA
interface. Directly within runtime application is implemented also OPC AE server that can generate
alarms and events based on values of SNMP variables or variables affected by JScript engine
functionality.

Available OPC server interfaces can be enhanced by OPC UA, OPC XML DA and OPC DA automation
by wrappers delivered within product SAEAUT SNMP OPC Server™ .

Using SNMP agents running on managed devices, it is possible to transfer a lot of information, but
SAEAUT SNMP OPC Server™ can gain leastwise information about availability also from unmanaged
devices (without SNMP agent) . It is achieved using ICMP ping protocol. Every unmanaged device
communicating with IP protocol can have defined variable within SAEAUT SNMP OPC Server™
address space where information about round trip time can be periodically actualised.
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Figure: Using of SAEAUT SNMP OPC Server (simple block diagram).
1.7.2 SNMP
Background

The Simple Network Management Protocol (SNMP) is an application layer protocol (according to
RFC 1157) that facilitates the exchange of management information between network devices. It is a
part of the Transmission Control Protocol/Internet Protocol (TCP/IP) protocol suite. SNMP enables
network administrators to manage network performance, find and solve network problems, and plan for
network growth.

An SNMP-managed network consists of three key components: managed devices, agents, and
network-management systems.

¢ A managed device is a network node that contains an SNMP agent and that resides on a
managed network. Managed devices collect and store management information and make this
information available to network-management system using SNMP. Managed devices,
sometimes called network elements, can be routers and access servers, switches and bridges,
hubs, computer hosts, or printers.

e An agent is a network-management software module that resides in a managed device. An
agent has local knowledge of management information and translates that information into a
form compatible with SNMP.

¢ An network-management system (NMS) executes applications that monitor and control
managed devices. an network-management system provides the bulk of the processing and
memory resources required for network management. One or more network-management
systems must exist on any managed network.

SNMP Basic commands

Managed devices are monitored and controlled using three basic SNMP commands: read, write, and
trap.

e The read command (GET) is used by an NMS to monitor managed devices. The NMS
examines different variables that are maintained by managed devices.

e The write (SET) command is used by an NMS to control managed devices. The NMS changes
the values of variables stored within managed devices.

e The trap command is used by managed devices to asynchronously report events to the NMS.
When certain types of events occur, a managed device sends a trap to the NMS.
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SNMP Management Information Base

A Management Information Base (MIB) is a collection of information that is organized hierarchically.
MIBs are accessed using a network-management protocol such as SNMP. They are comprised of
managed objects and are identified by object identifiers.

A managed object (sometimes called a MIB object, an object, or a MIB) is one of any number of
specific characteristics of a managed device. Managed objects are comprised of one or more object
instances, which are essentially variables.

Two types of managed objects exist: scalar and tabular. Scalar objects define a single object instance.
Tabular objects define multiple related object instances that are grouped in MIB tables.

An example of a managed object is atinput, which is a scalar object that contains a single object
instance, the integer value that indicates the total number of input AppleTalk packets on a router
interface.

An object identifier (or object ID) uniquely identifies a managed object in the MIB hierarchy. The MIB
hierarchy can be depicted as a tree with a nameless root, the levels of which are assigned by different
organizations.

The top-level MIB object IDs belong to different standards organizations, while lower-level object IDs
are allocated by associated organizations.

oot

it (0) Jerl-so-ceilt {3)

i (1)

arg (3)
dod (6]

duactony (1) mdemal (1) —a—1381

pirvatie (4)

mgmt (2}

exparimental (1) enlerpnses (1)
136,141 2682 1 —= dpsAlarmControl (1) J.. dpsinc (2682)

ThonXM (1) dpsRTU (2)

dpsRTUsumPClr (102)

Vendors can define private branches that include managed objects for their own products. MIBs that
have not been standardized typically are positioned in the experimental branch.

The managed object atinput can be uniquely identified either by the object name—iso.identified-
organization.dod.internet.private.enterprise.cisco.temporary variables.AppleTalk.atinput—or by the
equivalent object descriptor, 1.3.6.1.4.1.9.3.3.1.

Copyright © 2004-2013, SAE - Automation, s.r.o. (Ltd.), All rights reserved.



17 SAEAUT SNMP OPC Server™
1.7.3 OPC
OPC History

OPC is an industry standard created in a collaboration of a number of leading worldwide automation
and hardware software suppliers working in cooperation with Microsoft. The organization that manages
this standard is the OPC Foundation. The Foundation has over 500 members from around the world,
including all of the world's major providers of control systems, instrumentation, and process control
systems.

Originally based on Microsoft's OLE COM (component object model) and DCOM (distributed
component object model) technologies OPC defined a standard set of objects, interfaces and methods
for use in process-control and manufacturing-automation applications to facilitate inter operability. The
COM/DCOM technologies provided the framework for software products to be developed such that
upward migration and support of legacy applications is provided as the foundation.

OPC provides common standard interfaces for the sole purpose of facilitating inter operability between
software components for a variety of different applications. Different specifications have been specified
to provide standard interfaces to address the various needs of the overall industrial automation

marketplace, inclusive of supporting new technology and the ever changing needs of the marketplace.

OPC Fundamentals

OLE for process control (OPC) is a standard mechanism for communicating to numerous data
sources. It is an open and effective communication architecture concentrating on data access.

OPC was based on Microsoft's OLE/COM (DCOM) technology for data exchange between
applications. The OPC was designed by OPC Foundation organization.

The architecture of OPC is a client-server model. OPC servers and OPC clients may be provided by
different vendors (vendor independence). More than one OPC clients can be connected to one OPC
server at the same time (multi-client access). An OPC Client can connect to OPC servers running on
different nodes of the network (network access).

OPC Servers
OPC servers can be divided into following types:

¢OPC Data Access

¢OPC Alarms & Events
¢OPC Batch

¢OPC Data eXchange

¢OPC Historical Data Access
¢OPC Security

¢OPC XML-DA

¢OPC Complex Data

¢OPC Commands

¢OPC UA

OPC DataAccess Servers provide the access mechanism for OPC Clients to get the current state of
the device sources.

OPC Alarm&Event Servers provide the mechanisms for OPC Clients to be notified of the occurrence of
specified events and alarm conditions. Provides alarm and event notifications on demand (in contrast
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to the continuous data flow of Data Access). These include process alarms, operator actions,
informational messages, and tracking/auditing messages.

OPC Data eXchange specification takes us from client/server to server-to-server with communication
across Ethernet fieldbus networks. This provides multi-vendor interoperability! It adds remote
configuration, diagnostic and monitoring/management services.

OPC Historical Data Access - where OPC Data Access provides access to real-time, continually
changing data, OPC Historical Data Access provides access to data already stored. From a simple
serial data logging system to a complex SCADA system, historical archives can be retrieved in a
uniform manner.

OPC Security - All the OPC servers provide information that is valuable to the enterprise and if
improperly updated, could have significant consequences to plant processes. OPC Security specifies
how to control client access to these servers in order to protect this sensitive information and to guard
against unauthorized modification of process parameters.

OPC XML-DA was developed to provide flexible, consistent rules and formats for exposing plant floor
data using XML, leveraging the work done by Microsoft and others on BizTalk, SOAP, and other XML
frameworks.

OPC Complex Data is companion specification to Data Access and XML-DA that allows servers to
expose and describe more complicated data types such as binary structures and XML documents.

OPC Commands -set of interfaces that allow OPC clients and servers to identify, send and monitor
control commands which execute on a device.

OPC Unified Architecture is new set of specifications that are not based on Microsoft COM that will
provide standards based cross-platform capability.

vision of interoperability in multi vendor systems has become a reality, via the OPC standards.
Certification is the process of ensuring that applications meet the standards. OPC Certification
programs include Self-Certification, Interoperability Workshops and 3rd party testing by Independent
Certification Test Labs.
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Figure: Tool to provide compliance test
OPC Server interfaces

An OPC client application communicates with an OPC server through the specified custom and
automation interfaces. The custom interface can be used by function pointer oriented languages, such
as C++. The automation interface can be used by script languages, such as Visual Basic. OPC servers
must implement the custom interface, and optionally may implement the automation interface. OPC
Foundation provides a standard automation interface wrapper, which can be used by any custom-
server.
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Figure OPC client / OPC server cooperation over custom or automation interface.
OPC Data Access Server

All OPC DA Servers are comprised of several objects: the server, the group, and the item.

The OPC server object maintains information about the server and serves as a container for OPC
group objects. It provides functions such as getting of the server status information and browsing of the
servers address space. The server address space is a set of all available data items of the server.

The OPC group object enables to group data items. Also, it enables data exchange between OPC
server and OPC client. The OPC client can periodically read and write data to the items in the group.
Also, the OPC group object enables to create exception based connections between the client and the
items in the group. An OPC client can configure the rate at which an OPC server should provide the
data changes to the OPC client.

The OPC item objects represent connections to data sources within the server. An OPC item, from the
custom interface perspective, is not accessible as an object by an OPC client. Therefore, there is no
external interface defined for an OPC item. All access to OPC items is via an OPC group object that
"contains" the OPC item, or simply where the OPC item is defined.

The OPC item object is accessible as an object only from the automation interface perspective. It
enables to maintain the item status and to read and write to the item.

All objects - server object, group objects and item objects are COM-objects. The methods of the
objects are organized into logical groups - interfaces. These interfaces are common for all OPC
servers. The OPC servers must have all required interfaces implemented. Some of the interfaces are
optional. Optional interfaces do not have to be implemented.
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Figure: OPC server / OPC client - mapping of data

Data in the OPC server are organized either flat or in a tree structure. OPC server consists of devices,
which can have items (tags) defined. Clients can than access signle items in the server or groups of
items. On the side of a client it is created a tree structure, which includes groups that have items
defined. The groups in general are not the same as the devices in the OPC server (but could be) and
different client can have different groups of items defined. Single items could be repeated in the same
client in the several groups. For each group, client can define different properties - for example
different time of reading values of items in the group.

ICMP ping

Ping is a computer network administration utility used to test the reachability of a host on an Internet
Protocol (IP) network and to measure the round-trip time for messages sent from the originating host
to a destination computer.

Ping operates by sending Internet Control Message Protocol (ICMP - rfc 792) echo request packets to
the target host and waiting for an ICMP response. In the process it measures the time from
transmission to reception (round-trip time).

Within SAEAUT SNMP OPC Server™ , it is used two fold — to identify IP devices in network by
configuring. (It functions only on devices that do not have disabled pinging), and for continual
monitoring — cyclic measuring of round trip time of the unmanaged or also managed devices.

JScript

JScript is the Microsoft implementation of the ECMA 262 language specification (ECMAScript Edition
3). With only a few minor exceptions (to maintain backwards compatibility), JScript is a full
implementation of the ECMA standard. The JScript is an interpreted, object-based scripting language.
Although it has fewer capabilities than full-fledged object-oriented languages like C++, JScript is more
than sufficiently powerful for its intended purposes. JScript is not a cut-down version of another
language (it is only distantly and indirectly related to Java, for example), nor is it a simplification of
anything. It is, however, limited. You cannot write stand-alone applications in it, for example, and it has
no built-in support for reading or writing files. Moreover, JScript scripts can run only in the presence of
an interpreter or "host", such as Active Server Pages (ASP), Internet Explorer, or Windows Script Host.
JScript is a loosely typed language. Loosely typed means you do not have to declare the data types of
variables explicitly. In fact, JScript takes it one step further. You cannot explicitly declare data types in
JScript. Moreover, in many cases JScript performs conversions automatically when needed. For
instance, if you add a number to an item consisting of text (a string), the number is converted to text.

SNMP OPC Server proposes two ways of data processing using JScript - recomputation of the value of
existing OPC item (by reading, writing or both) or creation of new OPC item (called Script item) as a

Copyright © 2004-2013, SAE - Automation, s.r.o. (Ltd.), All rights reserved.



Introducing SAEAUT SNMP OPC Server 22

result of procesing none, one or several SNMP values.

1.7.5.1 JScripts for data processing

SNMP OPC Server allows user to execute data pre-processing right inside the server runtime
application using JScripts. It enables two ways of data pre-processing:
e recomputation of the value of existing OPC item associated with MIB variable on a connected

device
e creation of new OPC item (called Script item) as a result of procesing none, single or several MIB
variables.

In the first case, user can accomplish recomputation of OPC Item through the use of created JScript
after read or write its value. When the new Data Item is created (user can check the check box Use
script in the configuration dialog view. After that, in the edit box, two function headers for JScript are
created. SNMP OPC Server allows user to define, when the JScript with processing algorithm will be
executed - after reading of the OPC value or before writing of the OPC value. The processing of the
value will be excuted in the following sequence (first reading, than writing).

1. Read Dataltem —1
7 Resd vake _/"/(—_— H__.Jl
(123457002 OFC Client
f_‘jg
-\E.__?;ﬂ SHMP OFC Server
Metwork device 5. Datallem = 1.5
wilh SNMP agent
Gl
3 Value is 1500 i
(123457002

4. Datateen = 1 =]

JSeript

Figure: Pre-processing by reading of value by OPC client.

1. Write Dalaltem = 1.5 ;I
4. Wite value = 1500 ﬁ =

(1234570032

| c 2. Dataltem = 1.5

== SMNMP OPC Server

Network device
with SMMP agenit
3. Dataltern = 1500 [ ,‘5
JScripd

Figure: Pre-processing by writing of value by OPC client

This way of the data processing can be used e.g. in case of processing raw values to their engineering
form. The disadvantage of this processing of the OPC item is possibility to process only one value
without possibility to use futher OPC values in this JScript. However, by mentioned processing

global JScript variables can be used within JScript functions and so to reduce mentioned limitation.

The second way to pre-process data right in the SNMP OPC Server is creating the new OPC item as
JScript Iltem. This is special OPC Item, whose value is defined by return value of the JScript function,
in which none, single or several SNMP values from defined SNMP devices stored in the database can
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be processed .

For creation of such script Iltem, user has to push the right mouse button on the item Address space in
Item list control. From the pop-up, command New -> Script item has to be choosen. (These items
can't be organized in the folder structure and added to existing devices). After choosing this command
following dialog will be displayed

The user can define the name of the new OPC (Script) item, its description and data type (the same
data type as returned value of JScript is the condition for this data type value) here.

Next, user can define the items which will be presented as input arguments of JScript. These items
can be already defined items with OID in the database or new OID items but from defined devices. If
the user wants to use as input argument the existing SNMP values, than he can choose these values
from he predefined list or he can type the new value os OID (in the box Device, the device which has
the item with new OID, has to be choosen).

|rput iterns

Object 1D: " Device: w

J5 wvarable name:

Hame Dbject!D Device

A1 136121110 SAE4

A2 J.361.21.21.0 TestDevice
Al 13614115002 SAE4

Ad J1.361.4115003 TestD evice

Figure: Configuring of OID's that have to be used by computing JScript OPC item.

In the edit box JS variable name (Figure above), user defines the name of chosen SNMP value which
will represent this value in the JScript. Here user can find the list of all defined values that will be used
as input arguments for JScript. The values can be also removed from this list.
The body of the JScript is in the bottom part of the configuraton dialog. The function header and input
arguments are created automatically, user only defines the body of the script.
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2. Run JSoript 5, Datallam = 1.5
3. Read value
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(1234570023

Figure: Pre-processing by reading of JScript OPC item by OPC client.

According to client's requirements for reading of this script item, the server starts the JScript, reads all
input values, processes the JScript and then returns processed value back to the client.
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1.7.5.1.1 Global JScript variables

Global JScript variables behave as standard global variables, it means they are visible and usable in
any defined JScript. They can store and pass data actually or previously read, and thus enable
processing over actual and historical data. Global JScript variables can be defined as numerical, string
and array variables. Specially global variables of array type facilitate work with historical data.

Global JScritp variables are listed in a TreeView in a folder called Global JScript variables.
When adding a new variable, user right-clicks on this folder and chooses New Global JS variable item.

ﬁSNMPEunfMB_II.mdh - SMMPOpcServerConfigurator 10 x|
File Edit Wiew Go Tools Help

RS I ==
’8 Address Space Mame ¢ | Crescription | Craka Type | Default Yalue | MumOFElernents |

Conversions [A]g_bTest Eiool 0

@ Sirulation Signals [#o_strTest String kest
B-{@a] Alarm Definitions

&=
g_bTe:
i a_sttT pepame

Delete

ok

Copy
Paste

Large Icons  F7

Small Icons  Fa

Lisk Fa
* Details Fi0

Dialogpwiew  FLL
Monitor view F12

IMIE Browse

Insert Mew 'Global 15 Variable', |2 Object(s) MLIM S

Figure: Creating of new global JScript variable

Defining of the variable is designed similaraly as of Data items. User defines unique name, chooses
the data type of the variable and sets its default value. If user does not define default value, it is set to
zero or empty string in case of string data type. In addition user can define an array of chosen data
types with a specific length. Arrays are supported for all the data types apart from string data type.
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Figure: Dialog View - global JScript variable

Following example is a demostration of possible using of global variables in computing running
average over ring buffer, which represents simple filtration of a variable. Used global variables are
g_alnPkts (represents an array where the values of input SNMP packets (inPkts) are stored),
g_nLength (represents the length of the array), g_nPointer (represents a pointer in an array).
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;-';'-; M ame: ISNMF‘_InPkts_.-’-'-.wg
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function OnltemBead SNMP InPkts Avrg(inPkts)
i

war tmpsumw = 0;

war i;

if (g nPointer »>= 5j
g _nPointer = 0;

g_alnPkts[g nPointer] = inPkts;
g_nPointer++:

forii = 0; i < g nLength; i++4)
i

if{g alnPktsa[i] !'= -1)
tmp3wm += g alnPkts[i]:
el=e
hreak:

return [(tmp3umdi);

+
4
Al I Reset Add Mew

Figure: Example of global JScript variable usage.

1.7.5.1.2 Examples of using JScript

Using JavaScripts in SNMP OPC Server - Examples

| »

e Example 1 - Watch and test input variables, using of math functions

e Example 2 - Storing data in array, the processing of those data
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o Example 3 - Control of the output, using of internal functions and user's defined functions
1.7.5.1.2.1 Example 1

This script reads the value of the given input Data Item, make some mathematical operations ( sqrt,
round ), and than compare it with the max value saved as global variable. If this max value is
exceeded, a warning text is shown, and new max value is set.

First, new global variable called g_max is created, to store the max value:

Mame: @ mes
Diescription:  max vahee of some nput

Waniable properias
Diata Type: Drefaudt value:

ULONG ] 0

[JaRRsy  Humber of elements:

Second, a new Script Item called Watch is created. Than add new JS variable, set name to input, and
set Item Path to the data item, that we want to watch.

Herre: [Watch

Description: watch and test zome input vanabls:
MNOTE: Fefurn waluwa fiom scopt must ba sama

Cratal 3
WEE Qchet Sting ¥ az ssleched data lype.
Input kems
Denviee vl J5 vatiable nams:
ltem path
Mlame ObjeciD Davice ItemPath
input JAE14117.005  Malin enteipeizes 17_0_0_5
%] >

And the script :
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// watch given input, modify it, and if it is higher than
// max value, show message, and set new max value
function OnltemRead Watch(input)

{

var RetVal;

// examples of mathematical operations
var v = Math_sqrt(input);
var r Math.round(v);

// compare with max value
if (r >gmax )

// if max value exceeded, show warning, and set new max
Retval = "MAX VALUE EXCEEDED";
g_max = r;

} else {
// else everything OK

Retval = "VALUE IN RANGE";
}

return RetVal;

1.7.5.1.2.2 Example 2

Here we wil show :
- how to save last 5 values of some variable
- how to view these stored values to user
- statistical processing of these values, computing of average value

First, we need to create global array of size 5, we will call it g_history:

Mame: g hssley
Descriptions | last 5 values of some vanable

Walizble propeilies

Ciata Type: Dredek valie
LONG ~| 0
[#laRR&Y  Mumbes of elements: 5

This array should be the same type as the watched item, in our case it is LONG. To save the values of
this item into g_history array, the following script is used:
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function
OnltemRead_MartinPC_enterprises_enterprises_15 0_0 _4(enterprises_15_
0.0 4)

{

// save last 5 inputs into g_history
var i;

// shift left values in g_history
for ( 1=0; i<4; i++ )

g_history[i] = g_history[i+1];
// set new top value
g_history[4] = enterprises_15 0 0 4;

return enterprises_15 0 0 4;

}

function
OnltemWrite_MartinPC_enterprises_enterprises_15 0 0 4(enterprises_15
_0.0 4%

{

}

return enterprises_15 0 0 4;

The script to view these 5 values :

// function shows last 5 values of some input
// these values are saved iIn g_history global array
function OnltemRead_LastValues()

{
var Retval = "';
var 1i;
// show all values in []
for ( 1=0; i<5; i++ )
Retval += "'[" + g_history[i] + "]";
}
return RetVal;
}

And the computing of average value :
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// compute the average of values in g_history
function OnltemRead_Average()

{

var Retval = "'";
var avg=0.0;
var 1=0;

// compute sum of the values
for ( 1=0; i<5; i++ )
{

avg += g_history[i];
// divide the sum with the number of elements
avg /= 5;
Retval = "Average = " + avg;

return RetVal;

1.7.5.1.2.3 Example 3

This example shows how to use JavaScript to control or configure the output of SNMP OPC Server,
and how to use internal and user's defined functions. According to the input value, the output will show
today's date, or current time.

First, new Script Item called DateTime is created:

Hame: DataTime

Descipton: Showe cumant date o T

Data lype: | Dicket Siring “'l I:g[lsTje:tﬁI:ijér;;at:.Jsilm seiiph musl be zame
Device: | IS vaisble riame
Item pathe
Hame Objeciil Device IhzmPath
IrpLk JAE1.4115008  MakinPC ertempiizestertepiines 15 0 0 9
< »

Than add new JS variable input, and set the Item Path to the Data Item. The output is different,
according to the input value:

0 — View today's date

1 - View current time

2 — View both, date and time

Other — Undefined command

And the script :
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// according to input value, shows current date or time
// the input is a data item
function OnltemRead_DateTime(input)

var RetVval;
switch( input )

// it 0 show date
case 0 : RetVal = GetCurrentDate();
break;

// it 1 show time
case 1 : RetVal = GetCurrentTime();
break;

// if 2 show both, date and time
case 2 : RetVal = GetCurrentDate();
Retval += " '';
Retval += GetCurrentTime();
break;

// it 3 undefined commands
default : RetVal = ""UNDEFINED COMMAND';
break;

¥
return RetVal;

}

// get current date in format : "DD.MM.YYYY"
function GetCurrentDate()

{ (R0
var s = ;
dt = new Date();
s = dt.getDate(); // days
s += """ + ( dt.getMonth() + 1 ); // months
s += "." + dt.getFullYear(Q); // years
return s;

}

// get current time in format "HH:MM:SS"
function GetCurrentTime()

{ (R0
var s ="";
dt = new Date();
s = dt.getHours(); // hours
s += "' + dt.getMinutes(); // minutes
s += "' + dt.getSeconds(); // seconds
return s;

}
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2 Working with SAEAUT SNMP OPC Server

Steps that have to be / can be done depend on installed product modification. Following steps,
described bellow are for the most complete modification — SAEAUT SNMP OPC Server™
PROFESSIONAL (in modifications BASIC and ENHANCED some steps can not / need not be done):

e |nstallation of SNMP services and MS IS

SAEAUT SNMP OPC Server™ runtime application uses services SNMP service and SNMP
Trap that can be turned on as Windows OS features. Please turn them on. If you will use XML DA
wrapper or SAEAUT OPC WebView install also Microsoft Internet Information Services

e Installation of base applications — Configurator and runtime application

By installation of the product, first, only these two applications are installed. Others can be
installed later from START MENU of the SAEAUT SNMP OPC Server™ .

e [nstallation of other applications if you will use them — OPC XML DA and OPC UA wrappers,
SNMP agent, SAEAUT OPC WebView from START MENU of the SAEAUT SNMP OPC Server™ .

e Setting of Windows NT service features for SNMP_OPC Server running in service mode (if required)
There is possibility e.g. to set it to be started by start of the host computer

e Product activation — from demo mode to full featured mode
It is provided using software license key.

e Start Configurator
it will be started immediately after installation with demo configuration, or can be started from
START MENU

e Configuration of:
e Devices

e Manually

e Using IP scanner

Configuring of new simulation signals if you need them
Configuring of new alarm definitions if you will use OPC AE interfaces
Configuring of new conversions if you need them

OPC items / OID's

o Directly using dialog OPC items dialog boxes

e By scanning of connected devices for MIB variables

e By import from MIB files

JScript processing by reading/writing of MIB variables
Pre-processing for OPC items mapped only to JScript variables
Define global JScript variables (if you need them)

e Set options in Configurator

Testing of pure SNMP _communication with devices from Configurator

Activation of the actual configuration

Start OPC server runtime from Configurator and watch OPC item values in Monitor view
View log files in Log file viewer if a problem occur

Start of the wrappers (if necessary)

Start of the SNMP OPC Server runtime as Windows NT service (if not started by an wrapper)
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o Start of the SNMP OPC Server runtime by an OPC client application (if not started by an wrapper or
as Windows NT service) .

o Use SAEAUT OPC WebView to read / write OPC items over Internet /intranetTest and learn using of
TRAPs with SAEAUT SNMP Agent

e Use source codes of OPC client applications as templates by development of your own OPC client
applications

Product instalation

1. Lunch the installation application - the installation of SAEAUT SNMP OPC Server™ will be started

T Setup « SAEAUT SNMP OPC Server, Version 20000 Professional = B8

Welcome to the SAEAUT SNMP
OPC Server, Version 3.00.00
Professional Setup Wizard

Thes vl install SAEAUT SMMP OPC Server, Verson 3.00.00
Professonal on your (omputes,

[t i recommenadad Shat you doss sl ather applcabons before
oM,

Chck Mexct b conbinue, o Cancel o et Sebup,

Mext> | | Conesl
2. Confirm license agreement
" Setup - SAEAUT SHMP OPC Server, Version 3.00.00 Professional = | B (.|
License Agreement -

Please read the folowing mportant nSrmabon Befone conimeng ]

Please read the following License Agreement. You must acoept the teyms of this
agresment befone conbnung with She nstalation,

SOFTWARE LICENSE AGREEMENT FOR ENDHUSER FOR SOFTWARE FROM
DO AN
SAF - fartomation, s.r.0., Mol Dubreca

Ths software bosnse agreement for end-user & legal agresment bebween you
[ty 0 o Gonporation) and companny SAE - RAGSASGN, 5.5.0. Movl Dubsics Ko
softmpre products of company SAE - Aubomabon, 5.7.0,, whech inchudes computer
softweare and assocated storage media with Shs computer software and printed
mateviais, and may ndude “orline” oF Secironms dooumeniaBon deleereg on
storage meda ((SOFTWARE PRODUCT® or "SOFTWARE). By instaling, copying,
o obhermine umng She SOFTWARE, you agree bo be bound by he terms of Ses

& [ acoept the agresment
I oy nok sccept e soreement

cBak [ mestr | [ comest

3 Select additional tasks

a) Choose the possibility to run SAEAUT SNMP OPC Server™ runtime as Windows Service if you like
(it is possible only in SAEAUT SNMP OPC Server™ Professional)

b) Install OPC core components - mostly it is not necessary - all components to run runtime and
configurator are installed anyway

¢) Add Windows firewall rules and settings for SNMP and SNMP TRAP services (it they are installed).
If you chose this option, you will mostly not need to configure settings for SNMP services by hand.
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" Setup - SAEAUT SNMP OPC Server (o =

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing SAEALT
SMMP OPC Server, then dick Mext.

[7] tnetall runtime as Windows service
[7] tnetall OPC Core Components (requires .NET Framewaork 2.0 SP1 or higher)
Add windows firewall rules to permit SMMP communication.

<Back || Next> | [ Ccancel

4. Chose placement of SAEAUT SNMP OPC Server™ - e.g. c:\Program FilesS\SAEAUT SNMP OPC
Serven\

™ Setup - SAEAUT SNMP OPC Server, Version 1.00.00 Professional = | & [

‘Whaene should SAFALT SHP OPC Sarver, Verson 100,00 Professonal be
Figtallead?

Setup wil nstall SAEAUT SNMP OPC Server, Version 3,00.00 Professional into
] the: Follovang Folder,

T coritirue, chck Next. [F you would ke to select o different folder, dick Browse.

'l

At least 43,9 MB of free disk space is reguired,

< Basck

[et> ] [ cons

5.Chose placement in START Menu
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" Setiap - SAEAUIT SHMP OPC Server, Viersion 300,00 Professional = ==
Select Start Menu Folder

Where thould Setp place the progras’s horbauts? “

I Sefup wil eate the program's shoriouts in the following Start Menu folder,

T coribrue, cho Mt [ you woukd Bee 12 esiect o dfferent folder, choe Browss.

SAERLT SHMP OP S Ergrivia....

qhdjl-m::lhtnﬂ

6. Installation will be started

”f‘m-mmmhmmmnﬂm == R E-N
Installing

Pizase vein? while Sehup iratals SAEAUT SHMP OPC Server, Venson 3.00,00 m
Professonal on your computer,

Extracting fles...
CiWProgram Fles\SAEAUT ShP OPC Server b NET-5HMP-MIB, bat

7. When SAEAUT SNMP OPC Server runtime is registered you will see the reminder to "Enter Key".
You can do it now, as described in Product activation, or any time later.
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3

T Setup - SAEAUT SNMP OPC Server o || B &=

L'

o

58
N Installsng - .‘E
;I Please wait whie Setup installs SAEALIT SNMP OFC Server on your computer, =
]
b

Register OPC Server...
Reminder

|
| SAEAUT SMMP OPC Server is running in demonstration mode and will terminate after 1 hour.

0K button will be enabled in 2 seconds...

Enter Key

LS

8. It is possible to choose
a) to open release notes after installation
b) to start configurator after installation.

= Setup - SAEAUT SNMP OPC Server o | = e

Completing the SAEAUT SNMP
OPC Server Setup Wizard

Setup has finished installing SAEALT SMMP OPC Server on
your computer, The application may be launched by selecting
the installed icons.

Click Finish to exit Setup,

| View Relnotes. pdf
| Run SMMP OPC Server Configurator

There are some products in the installation package that can be installed from start menu later if you
need them.
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2.2  Product activation
In order to activate your software product to full version you will need to enter a name and the license
key. Please start the product you want to activate and click Enter key when asked about product
registration. You will see the dialog window that shows hardware fingerprint. Please e-mail us this
fingerprint and tell us the Name under which you'd like to activate your product. Based on this
information we will send you back the license key that can be used to activate your product.
To activate SAEAUT SNMP OPC Server™ version:
1. Install application SAEAUT SNMP OPC Server™ on PC where it will run.
2. Launch the SAEAUT SNMP OPC Server Configurator (Start d Program Files d SAEAUT SNMP
OPC Server d SAEAUT SNMP OPC Server Configurator).
3. Click on button ,Enter key".
Reminder
SAEAUT SNMP OPC Server is running in demonstration mode and will terminate after 1 howr.
OF button will be enabled in 8 seconds...
| Enter Key I
4. Make a copy of your PC ,Hardware fingerprint" (for example: Hardware fingerprint: A982-C842)
Enter Key @
E nter the reqiztration name and kew below, exactly as given to
WL,
Hardware fingerprint; 4382-C842
Mame: ||
ke |
OF. | Cancel
5. Please send us your ,Hardware fingerprint" and also Name (if you like) to e-mail sae-
automation@saeautom.sk.
On the basis of your PC ,Hardware fingerprint”, we will generate the valid ,Enter key" for your PC and
send it back to you.
Please see the video about product activation.
Remark: It is possible to test full functionality of the SAEAUT SNMP OPC Server™ also without
activation, but restart always after 1 hour of running is necessary.
2.3  The first start of SAEAUT SNMP OPC Server

Configurator Start

After installation of the SAEAUT SNMP OPC Server™ | in case that you picked out this option in the
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last installation dialog box, configurator will be started with the demo configuration SNMPconf. If not,
you can start it from the start menu using SAEAUT SNMP OPC Server -> SAEAUT SNMP OPC

Configurator.

" SNMPConf - SNMPOpcServerConfigurator = ===

File Edit View Go Tools Help

D & B4 B BEEETRe AT

E...gg Address Space ~ | Mame - | Object ID | Data Type | Access Ric
-] UPS_MIB_rfc1628 (£ sysDescr
=R ] localhost Ll sysName

23 sysDescr ([ sysUpTime

- ilab] system_sysDescr 0
l:l sysMame
l:l sysUpTime

----- IScriptVersion I-@ Hame: ||':"3‘5'|h':'St

----- Random _From_10_To_20 IP Address: [127.0.01
----- SystermLastReinitializedTime

4 1 3

m

m

(] Conversions Carmrnunity: ||:uu|:u|i|: v Mz

&-{&] Simulation Signals _ _

w1-{@a) Alarm Definitions Connection settings il
--{i7] Global JScript variables - |4 1 b

Ready 3 Object(s) MNUM

Figure 1: Configurator with demo configuration SNMPConf.

Within tree view Address space (Figure 1) you will see preconfigured two devices — UPS_MIB_rfc1628
(for now, we will not work with that) and localhost (there are preconfigured some MIB variables that
can be accessible on your computer in case that Windows service the SNMP Service is running ) .
There are also some JScript variables — JScriptVersion, Random_From_10to_20,
SystaemLastReinitialisationTime.

Runtime Start

As the configurator contains an OPC client (Monitor View) we can use it to start SNMP OPC Server
within runtime application. (If you chose Install as Windows Service during installation it will be already
started and OPC client only connect to that.)

Please click on menu-item View -> Monitor View or toolbar-item Monitor View.
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Toolbars »
v Sktatus Bar

Lisk Fa
* Details Fi0

v Monitor view
Sort by »
Shiow/hide columns »

Global Refresh FS
Subtree Refresh  ChrHFS

O = [ 4 B

click on
Monitor Yiew

Figure 2: Start Monitor View OPC client

After that, Monitor View in the configurator will be open. But, we will probably see none OPC items in
that. To be able to see OPC items from a folder under the folder Address space in tree view, we need
to click on the folder from that we want to watch OPC items. To watch the JScript variables we can
click on Address space folder itself. Now we can see values of the JScript variables in the Monitor View
and also their Quality and Time stamps. These variables are not mapped on any MIB variables. They
show return values of functions running within JScript engine. Their quality should be good even if
SNMP service does not run.

SNMPConf - SNMPOpcServerConfigurator == =s

e Edit View Go Tools Help

~ e | [ob
1@ *“11In the itor View ?

-+ Address Space - will be Simulate Address | Communi Timeout | Retries | Manag... | Generate Alarms
& . ty g9
2-fii] UPS_MIB_rfc1628 shown OPC items - 2 "
_MIE_| from chosen No 127001 public 1000 - -
] localhost folder Address No 127001 public 1000 The llt;aal:?ar;;gs-lﬁcnpt

JScriptVersion .S pace
Random_From_10_To_20

SystemLastReinitializedTin

o

can be good even if SHMP
service is not activated
because none SNMP MIB
variables are uszed in J5cript
functions within

Yalues of J5cript
varaibles are

= T g
generated by JScript

m ID LSS ELEL (I Timestamp Quality
- - configurator - . —
I5criptVersion ript ..  10/04/13 12:52:38.013 Good on-specific Mot Limited
Random_From_10_Te 18 (VT_UK) 10/04/13 12:54:46.365 Good MNeon-specific Mot Limited =

o oo

1 b

¥

Figure 2: JScript variables in Monitor View - they show return values of functions programmed using
JScript
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" SNMPConf - SNMPOpcServerConfigurator

File Edit View Go Tools Help

0= |2 Ber| A7
[1-fff] UPS_MIB_rfc1628 + | Name / | Object ID Data Type Access Rig... | Usetrap | Description |
i lecalhost L i ol i 136121.. Timeticks Read only Mo "The time (in hundredths of a second) since the ...

{1 sysDescr 5 sysllpTime

the directory chosen
{3 syshName to show in Monitor View
=4 sysUpTime e
system_sysUpTime _
EE R v TR S H
— — Bad quality means that

1 m ' 7 Name ot InTims SNMPF Service is not
Item ID Value Timestamp Quality Subquali% Sla'l::n"’i'gﬁ::::fc"-v
localhost.sysUpTime.system_sysUpTime 0 777 10/04/13 12:56:29.611 m Comm Fai

1 Object(s) NUM

Ready
Figure 2: OPC Item related to MIB variable in Monitor View.

Remark: By installation of the SAEAUT SNMP OPC Server™ also the SNMP Service in Windows is

configured and started. However, by next start of your computer it may be will not be running if you

have not configured it to start when computer is starting. There can be also problem with configuring

SNMP Service by installation in case that you have not installed SNMP Service in advance. In such
case please set it by hand as described in white paper or shown in video.

Related articles
How to access SAEAUT SNMP OPC Server data through Internet

How to use SAEAUT SNMP OPC Client

2.4  The user interface (Overview)

The configurator is the graphic configuration part of the SNMP OPC server, which helps user to
configure the SNMP OPC Server. The configurator display is divided into several parts

M avigation menu
Standard buttong toolbar ,

Dretailz
[rata manipulation

buttans toalbar

Pyl - SR e v | s

Fie Bt ma Tomk Help

“‘-\\_ﬁj_u:.r Lk ewm g e afEE e v
Fe o 8| =
E1 1 Addmm S Hare Smiate | Data T i Acceis Bgies | denevars ki

[0 saEz2 ded e
Be
/ =1 |
T Comversices
i () Srwilncon Sgr
11 (] ki Gefisteda
1] (] Glehial Teripk variah
e : -
. Dialag wisw
Tree view ) e o
control ™ Hwutie
¥ A Mew I
b cnitor wiew
[in-built OPC client]

\ Bew I e | rerestann | cusey bty Liw
il | H
Ay - 1 Dbyectis) WM B

Statuz bar
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e Navigation menu
e Toolbars
e Tree view
2.4.1 Details

For folders Address Space, Conversions, Simulation Signals, Alarm Definition and subfolders of the
Address Space folder you can display the Detalils. It is the table with the information about all items in
the selected folder.

In this Detail view you can order items by each column by command View—>Sort by.... And you can
hide or display columns by command View—->Show/Hide columns.

Details for Address Space

Mame | Simulate | .ﬁ.ddressl Cu:ummunit‘;.fl Timeu:uutl Retries | Managed |
mS.ﬁ.Efl Mo 192.168.16.81 private 1000 3 -1

Details for Conversions

_Mame ¢ | Type | Low ELI | High ELI | Loy IR, | High IR | Clamping | Lo Clamp | High Clamp |
Default Linear Linear 0 100 0 10000  Clamp on EL 1] 100
Defaulk Square Root Square Root 1] 100 0 10000 Clamp on EU 0 100
Mone (toffrom Floak) Mone ] 100 0 10000 Mone 0 100

Details for Simulation Signals

Mame | Type | amplitude | Mumber of steps | Period | Phase I Position I Ratio I AI
[y 100*Ramp(T) Ramp 100 5 1 0 0 0,333333333333333

By 100*Ramp(T/10)  Ramp 100 3 10 0 0 0,333333333333333

[y 100*Ramp(T/1000  Ramp 100 3 100 0 0 0,333333333333373

% 100*R.andom Sine 100 3 1 ] 0 0,333333333333333

[y 100*Sine(T) Sine 100 5 1 0 0 0,333333333333353

[y 100*Sine(T/10) Sine 100 3 10 0 0 0,333333333333333

[y 100*Sine(T/100)  Sine 100 3 100 0 0 0,333333333333333

[y 100*Square(T) Square 100 3 1 0 0 0,333333333333333

[y 100*Square(T/10)  Square 100 5 10 0 0 0,333333333333333

[ 100*Square(T/100)  Square 100 3 100 0 0 0,333333333333333

[y 100%Skep(T) Skep 100 3 1 0 0 0,333333333333333 =
Details for Alarm definitions folder

Name | Hidival | Hival. | Loval | Loloval | Dig. value |

53, Default Limit Alarm (0-10-90-100) 100 a0 10 0

ag Cremo Limit Alarm Q0 a0 -80 -a0

53, Faster Limit Alarm {0-10-90-100) 100 a0 10 0

@u Default Digital Alarm (on TRUE) True (1)

@u Dermo Digital Alarm True (1)

Q; Faster Digital Alarm {on TRUE) True (1)
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2.4.2 Dialog view

There is a dialog view for every item in_tree view as well as for items that can be chosen from
navigation menu. They will be described in next chapters.

For example, the dialog view to define parameters for devices is in the figure bellow.

Hﬂ Mame: |SAE4

IP &ddress: |1 92.168.16.81

Comrmimity: Iprivate [~ Managed device

Connection settings

Connechion hme-out; I'I Qoo ms  |hetime-out parameter iz
doubled each time a retiy

Murnber of retries: |3 atternpt iz tranzmitted.

| Apply I Fezet | Add Mew | [ Sirmulate

Figure: Dialog view used to define parameters for devices.
All dialog views of the address space contain the same buttons:

Apply
Values written in the view will be saved to the configuration.

Reset
Values written in the view will be replaced by original values from configuration or by default values.

Add New
New item of the same type will be created and filled by default values that can by edited

Some dialog views contain check box Simulate. When checked in, instead of values from devices,
within OPC items in given folder, values of simulation signals (if defined for the OPC item.) will be
published.

2.4.3 Monitor view

The Monitor view is the in-built OPC DA client application. After this command the application will start
reading/writing data from/to the SNMP devices and it will display the results in the following view.

Ikem IO | Yalue | Timeskamp | Cuality | Subguality | Lirnik
SAE4.Ink 10 (WT_I4) 070405 12:33:39.431 (aood Mon-specific Mot Limited
SRES. 5ty "Test trap” (WT_BSTR] 070405 12:33:39.431 aood Mon-specific Mot Limited

Figure: Monitor view

See also
The first start of SAEAUT SNMP OPC Server
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2.4.4 Toolbars and Status bar

In the Configurator of the SNMP OPC Server there are two types of toolbar available. The first is the
toolbar with Standard buttons and then the toolbar for Data manipulation.

e Toolbar with standard buttons - Standard toolbar

S ENEE

Al e A

e Toolbar with buttons for data manipulation - Data manipulation toolbar

i o 1| %

There is also the Status bar available on the bottom of the Configurator window

Ready Z Ohijeck(s) LM
4

2.4.4.1 Standard toolbar

There are following buttons with predefined functions in Standard toolbar

[ [ IILLT

D& B & B EE g R

{dddddd

Create New project
Open project from the hard-drive

Not used

Not used

Move up one level
Standard Cut button
Standard Copy button
Stabndard Paste button
List in Details table

10. Display or hide Details table
11. Display or hide Dialog view
12. Refresh of Item list

13. Internal monitoring client
14. Help file

[+3]

CoNorWNE

2.4.4.2 Data manipulation toolbar

There are following buttons with predefined functions in Data manipulation toolbar
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@ @
N/
e A | %

N

O ®

Create new Device
Create new Folder
Create new Data ltem
Delete item

rpONDE

245 Tree view control

The SNMP OPC Server can define 5 categories of the items. All are stored in the Item list control. The
following picture shows this control.

" SNMPConf - SNMPOpcServerConfigurator | = || = |[s25]

File Edit View Go Tools Help

O = % EE: |iEE fi" | 4
F-+2 Address Space i | g
Conversions _ ree view P8 A

-] Simulation Signals localhost 7
.. Alarm Definitions [ )5criptVersion

..{] Global JScript variables [#)Random_From_10_To_... «

lm b

Ready L

Figure: SAEAUT SNMP OPC Server configurator - tree view
There are following items:

1. Address Space - contains Devices and the Data items related to MIB variables from managed
devices or round trip time of the ICMP ping for unmanaged devices. The data items can be
organized in a folder structure.

2. Conversions - SNMP OPC server allows you to create some conversion functions for reading
[/ writing the values from / to SNMP Agents

3. Simulation Signals - you can set simulations signal that can be offered to OPC client
applications instead of values from devices up.

4. Alarm Definition - defines alarms for SNMP OPC Server

5. Global JScript variables - defines global JScript variables

2.4.5.1 Address Space

Address space contains folders that are used as containers for OPC items and subfolders. There are
special folders on the highest level for connected devices. They can contain subfolders and OPC
items related to MIB variables. They can contain also OPC items associated with round trip time of
the ICMP ping responses for different devices.

Directly under folder Address space resides JScript items. These are OPC items related to return
values of functions written in JScript.
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There is also special folder for Global JScript variables that can be used for variables that can be
shared globally by all above mentioned JScript functions.

El-4E2 Address Space
5-fii] UPS_MIB_rfc1628
=-1 upsMIB

: - upsCom
&2 upsGroups
-1 upsObjects

=1 upsTraps

-
=-{1] lecalhost
D sysDescr
l:l sysMame
&-23 sysUpTime

Levice named
JPS_MIB_rfc162f£

EI{:I upsConformance

E||:| upsCompliances

o upsCompliances_upsBasicComp
upsCompliances_upsFullComplii

Folder
containing OPC
items related to

MIB vaiables
transferred in
TRAP meszage

..... lab| upsAlarmDescr

_ . ab| upsAlarmld

@' upsTrapAlarmEntryRermnoved
w3 upsTrapOnBattery

'-'F'STFEF'l Eewce name?

JScnpt
variables

Figure: Addressspace in the tree view

2.45.1.1 Dialog View Device

This dialog view enables to configure managed (with running SNMP agent) and unmanaged devices.

I'@ M ame: |I|:u:alh|:|st

IF fddress: [127.0.0.1

ComrmLinity: ||:uu|:|li|:

Connection settings

Connechion hime-out: {1000 ms
3

Murnber of retries:

o0 ]

attempt iz rans

| Add New |

=]

v tanaged device

The time-out parameter is
doubled each time a retry

rritted.
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Figure: Dialog View used to configure a device

Name
arbitrary within address space unique name that does not contain spaces.

IP Address
IPv4 IP address Xxx.yyy.zzz.www

Community
Community used for SNMP SET, GET and TRAP messages

Managed device
If checked in it is supposed that managed device is configured, Other way unmanaged device is
configured
Connection settings
Connection time-out
Time after that communication will be repeated if none answer has come from device and number

of retries is lower than configured

Number of retries
Number of retries if none answer from device

2.4.5.1.2 Dialog View Folder

It is used to organize OPC Items.

D M arme; |S_|,ISD BRI

| Add Mew

Figure: Dialog view to define standard folder to organize OPC items

[ Simulate

Name
arbitrary within address space unique name that does not contain spaces.

Simulate
When checked in, instead of values from devices, within OPC items in given folder, values of
simulation signals (if defined for the OPC item.) will be published.

2.4.5.1.3 Dialog ViewTrap Folder

It is used to organize OPC Items that are mapped to MIB variables transferred within SNMP TRAP.
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il Hame: |upsTrap.-'3.IarmE ntrpddded

Object 1D: |.1.3.E.1.2.1.33.2.3

| | Add Mew

Figure: Dialog view to define folder to organize OPC items associated with MIB variables transferred
within SNMP TRAP

Name
an arbitrary within address space unique name that does not contain spaces.

Object ID
ID of the SNMP TRAP. (can be found out e.g. from the MIB file of a device)

2.4.5.1.4 Dialog View OPC Item

The dialog view is used for:

Configuring of:

e OPC Item mapped to the MIB variable transferred using SNMP commands SET and GET

e OPC Item mapped the MIB variable transferred within SNMP TRAP — the check box
Notification (Use SNMP Trap) must be checked in

e Configuring of OPC Item mapped to round trip time of ICMP ping for the device - the check box
Heartbeat must be checked in

Assigning of:

¢ a simulation signal to the OPC item

e a constant value to the OPC item

e a conversion to the OPC item

e an alarm definition to the OPC item

Editing of a function(s) written in JScript:

o that is used for recalculating of MIB variable value to the OPC item value when OPC clients
reads from SNMP OPC server

o that is used for recalculating of OPC item value to the MIB variable value when OPC clients
writes to the SNMP OPC server

o that are used for both reading and writing

Sending SNMP command SET or GET to MIB variable on device with defined OID

Most important parameters (if the checkbox Heartbox is not checked in ) are in the group Item
properties. The Object ID is the SNMP Object Identifier for the tag. It is the specific data address for
the information you are requesting from SNMP agent embedded in your manageable network device.
Most MIB addresses follow an Object ID nomenclature that has a series of whole numbers separated
by periods (for example: .1.3.6.1.2.1.2.2.1.7.1.). To set up the Item you have to specify its Object ID
from MIB file of the device.
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;-?-; Mame: |upzCompliances_upsSubsetCompliance [ Heartbeat

Description: |"Suppart of the values unknown(1] and batteryDepleted(4] iz not required -

Item properties

Object 1D:
|1.361.21.32.31.1.0

E2

[ Manual
SHMP data type: Value: |
|Integer32 j
* Bead anly " Readfafrite [ Use conversion
™ Maotfication (Use SNMP Trap) Name:  |<Mat Assigned> =l
[v Use script
function OnltemRead UPS MIE rfecl Templates of onfor -
{ JScript functions
return upsCompliances upsSubse used for c

reacalculating by
reading or writing

function OnltemWrite UPS MIE rfcl&28 upsMIE upsConf:

{ -
4 i I
MOTE: Uze Chl pluz T jhdentation of the text af the script.
Conhiguning of
v Generate Alarms alarm for an
) - | OPC item
bezz. prefid |upsD:umphanu:es_
Walue: |Default Lirnit &larm [0-1 D-j
MOTE: Iterm access rights are MOT tested in validation.
SHMP wvalue
Sending of 5ET -
or GET
S5NMF commands
to the connected -
4 device ,
et Set |
&pply | | Heset |

Figure: Dialog view to define OPC items

Name
arbitrary within address space unique name of the OPC Item that does not contain spaces. It can be
edited by hand, imported on line from device or off line from MIB file of a device (the characters like
* 1 - _,;, "are not allowed).
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Heartbeat
If checked in, the OPC item will on runtime contain round trip time of the ICMP ping to the device

Description
It can be edited by hand or imported from MIB file of a device

Item properties
Object ID
OID of the MIB variable from device. It can be edited by hand, imported on line from device or off
line from MIB file of a device

SNMP Data Type
Type of data as can be read / written to the SNMP device

Read only - Read/Write
Access rights from OPC client to OPC server

Notification (Use SNMP Trap)
If checked in, it is supposed that MIB variable from device will be transferred within SNMP TRAP.
Other way SNMP GET / SET will be used

Simulate
If checked in, instead of a MIB variable OPC item will be changed according to predefined simulation
signal

Signal
Name of the predefined simulation signal

Manual
If checked in, instead of a MIB variable OPC item will have constant predefined value

Value
Value of constant predefined value

Use conversion
If checked in, predefined conversion will be applied on OPC item value by reading or writing

Name
Name of the predefined conversion

Use script
If checked in, calculations by reading / writing will be executed. Edit box is used as JScript editor with
highlighted syntax. Within functions can be used global variables. The result of editing can be found
in the file ServerScript.js in directory C:\Users\user\Documents\SAEAUT SNMP OPC
Server\Configurations\. In case that you want to open another configuration, please back up the file
first.

Generate alarms
If checked in, a preconfigured alarm definition will be associated with the OPC item.

Mess. prefix
A few OPC items can be associated with the same alarm definition. To distinguish alarm
messages for distinct OPC items a message prefix can be used.

Value
Name of the preconfigured alarm definition
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SNMP Value
There is possibility to verify OID on device on line and read / write values directly from configurator

GET
Value of the MIB variable will be read and show in edit box

SET
Value of the MIB variable edited within edit box will be sent to device using SNMP command SET

Remark: In case that check box Heartbeat is checked in, only Name and description has to be
configured.

2.4.5.1.5 Dialog View JScript OPC Item

JScript OPC items enable computing of OPC Items values using none, one or more variables
associated with MIB variables from devices.
In the figure bellow, the item is computed without variables associated with MIB variables. The return

value of the associated JScript function is string with information about JScript engine. Please see also
example of JScript OPC items using variables associated with MIB variables.
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;-?-; Harme; IJScripNersiDn

Dezcrption: I
Data type: . MOTE: Return value from script must be same
IEI::tetStrlng ;I az zelected data tupe.
— |nput itemsz
Device: I j J5 variable name: I
Itern path: I ;I Add | Chahge Bemaowve
I ame | ObjectiD | Device | [temPath
1 | mn b
— Script
function OnltemBead JScriptWVersion() -
{
var Ver = "You are using " 4+ ScriptEngine() + " Verziom ";

Ver += ScriptEngineMajorVersion() + ".";
Ver += ScriptEngineMinorVersion():
return Ver;

}

4 k

MOTE: Uze Chl pluz Tab to make paragraph indentation of the text of the scrpt.

| Generate &lams
bess. prefi I

Limnit larm: I <Mot Azsigned:> ~|  Digital Alam: | <Not Assigned: =]

Apply I Reset Add Hew |

Figure: Dialog view to define a JScipt OPC item.
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Name
arbitrary within address space unique name of the OPC Item that does not contain spaces. It can be
edited by hand, imported on line from device or off line from MIB file of a device (the characters like
* .1~ _,;, "are not allowed).

Description
It can be edited by hand or imported from MIB file of a device

Data type
Data type of the return value from JScript function

Input items
Configuring of items that will be used as input variables for JScript function

Device
Device from that variables will be used - device and variables must be configured in advance

JS variable name
Name of the variable that will be used in JScript function

Iltem path
Path to the variable from device - folder, sub folders, variable name. In the list box only variables
from chosen device will be listed

Add
adding of new variable from device

Change
changing of definition for the configured variable from device

Remove
Remove variable from list of input variables

Generate alarms
If checked in, a preconfigured alarm definition will be associated with the OPC item.

Mess. prefix
A few OPC items can be associated with the same alarm definition. To distinguish alarm
messages for distinct OPC items a message prefix can be used.

Value
Name of the preconfigured alarm definition

2.4.5.1.6 Dialog View Global JScript Variable

Global JScript variables enable to share values of variables between different JScript functions called
by data pre-processing in SNMP OPC server.

They can be defined as scalar variables or as arrays. Please see

example of working with global JScript variables.
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— = I

A1 Global JScrpt variables. Theze variables will be zaved after function execution and

- restored before function execution. You can freely uge thesze variables in your project.

Marme: |G\-’ar1

Deszcription: |e:-:am|:|le aof the global JScript wwarniable

“ariable properties

Data Type: Default value:
[FLOAT ~| | 559
W ARFAY  Mumber of elements: | 1

HOTE: Usze "' character to mark, flaating paint.

Apply | Beset |

Figure: Dialog view to define a global JScript variable.

Name
arbitrary within address space unique name of the OPC Item that does not contain spaces. It can be
edited by hand, imported on line from device or off line from MIB file of a device (the characters like
* .1 -, _,;, "are not allowed).

Description
Informative string to explain global variable

Variable properties

Data Type
Following data types for a variable can be chosen from list box: BOOL, DOUBLE, FLOAT, LONG,
STRING, ULONG

Default value
Default value of the scalar variable or all values in array

ARRAY
If checked in array of global variable will be created instead of scalar variable

Number of elements
Number of elements in array of global variables.

2.45.2 Conversions

You can tell the server to convert device data value simply settings the following properties. There are
two types of units:

e EU engineering unit (client scale)
¢ IR instrument range (device scale)

No conversion converts the data into float data type.
Linear or square root conversions keep a linear or square root relation between EU and IR.
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H/Lr. M arne: INew Conversior]

— Type of conversion — [~ Conversion parameters
" Mo [make float) Laow ELI: n High ELI: 100

% Linear
Lawa IR: I 1] High IR: I 10000
™ Sguare root o =

Mate: Engineering unitz [EL] can be zpecified even
with no converzion,

—Clamping —— [ Clamping parameters
" Mone

* Clamp on EU Low clamp: I 1] High clarmp: 100

Az zpecified

Apply I R ezet | Sddew |

Figure: Dialog view to define an OPC item conversion.

Note that definition of range limits helps some client applications and makes sense even when no
conversion is specified.

If clamping is on, the data value will be limited to its High clamp/EU value when it exceeds the upper
limit, and similarly with Low clamp parameter.

2.4.5.3 Simulation Signals

There is a wide range of simulation signals offered. You can select from them in the Type group of
radio boxes.

Read Count is incremented by one every time when the item is read (Write Count increments when
the item is written). Random generates random value within the Amplitude range starting with Position.
Ramp, Sine, Square, Triangle and Step are periodical signals. Their time behavior is influenced by
Period and Phase parameters. Period specifies the signal frequency, while Phase moves the signal
origin on the time axis.

Square and Triangle signal types have one more parameter: Ratio. Ratio defines Triangle signal
steepness, or Square signal H/L proportions. # of steps parameter of the Step signal defines a number
of steps that signal amplitude will be divided into.
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2454

% Mame: |Mew Signal

—Twpe —— | [ Parameterz
" Fead count

£ wihite count Fosition: I 0 Amnplitude: I 1

" Random
rf: Ramp Period [ms]| | 1000 Phase [deg): | a
* Sihe

" Square

" Triahgle R atic: I 1] # of steps: I 3

" Step

Apply I R ezet Sddew

Figure: Dialog view to define a simulation signal for an OPC item.
Alarm Definition

Alarm definitions are divided into two alarm template types: Digital and Limit (Analog) alarm definition.
Digital alarm can be defined for data item of BOOL type only, while Limit alarm definition for the rest
except String data type.

e Limit Alarm definition
e Digital Alarm definition

2.4.5.4.1 Digital Alarm

Update rate parameter defines the frequency of checking the data item value, and possibly responding
with sending the alarm message.

User can request the alarm when the value equals to TRUE or FALSE, define the Message body that
carries the information, and Severity, which is the alarm message importance. The Severity value
ranges from 0 to 1000.

Checking Return to normal will generate a separate alarm message when the data item gains the
opposite value.

Req. Ack. Tells the client that the alarm requires an acknowledgement. Then alarm message can be
not only sent, but also acknowledged, etc.
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Iﬁ] M arne: IFasterDigital.ﬁ.Iarm [on TRUE]

|lpdate rate:l 1000 mz

— Digital alarm definition

Severity; FReq Ack.:

¥ Enatle
W alle; tezzage Bodw:
[ True (1) | |Digital Alarm

RO v

¥ Fetum to nomal IHeturn ko Marmal

| addNew

| Lpply I Hezet

Figure: Dialog view - digital alarm

2.4.5.4.2 Limit Alarm

Limit alarm parameters can have subranges within the data item amplitude. Every subrange definition
includes Message body that will be appended to the alarm message, the Severity of the alarm and

Req. Ack. flag.

Update rate parameter defines the frequency of checking the data item value, and possibly responding

with sending the alarm message.

Dead band prevents the server from generating huge amount of alarm messages and overloading the
clients when the signal oscillates around one of the limits specified. Dead band value extends the limit
zone. It results in sending only one alarm message even if the signal oscillates.
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@J Name: [Dfault Limt Alarm (0-10-30-100]
lpdate rate; I 2000 mz Deadband: I 1
— Lirnit alarm definition
Lirnit: " alue: bezzage Body: Seventy: Reg. Ack.:
v HiHi | 100 [HiHi Level Alarm | &0 [
M Hi 90 fHi Level Alarm | s [
[ Returm to nomal IHeturn to Marmal
Ml | 10 |Lo Level Alarm | s [
¥ Lolo | 0 |LoLa Level Alam | &0
| Lpply I Hezet | Add Mew
Figure: Dialog view - limit alarm
2.4.6 Navigation menu
From navigation menu you can choose any commands of the SNMP OPC Configurator.
e File menu - commands for New project, Save project, Active database or Close the
application ...
e Edit menu - commands for creating new items, renaming or deleting existing ...
¢ View menu - here you can control displaying views of the configurator
¢ Go menu - contains commands for walking through items defined in project
e Tools menu - includes some options for SNMP OPC Server
e Help menu - displays this help file and information about application
246.1 File menu

In this menu you can create new project, load a stored project or save the current project. You can also
display the connection properties of the opened project, make some XML export, import and validation.
Here is also a command to make current project active.

Also contains list of the last opened projects and command for closing the configurator application.
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New Ctri+N
Open... Ctrl+Q
Save As...

Connection Properties...

View server script...

XML Export...

AML Export Schema...
AML Import...

AML Validate...

Bl A i
Wiaxe ACTne, ..

1 CA\Program Files\..\SNMPConf
2 Chlsers\..\SNMPConf

Eit

Figure: Menu File

Here is short description of each command:

2.4.6.1.1 New

Command New - creates a new SNMP OPC Server project (configuration mdb file)
Command Open - opens existing stored SNMP OPC Server project

Connection properties - information about active configuration file as well as used database
driver

View server script - shows all used JScript function used within a configuration with syntax
highlight

Command Save as - saves the current opened SNMP OPC project with defined name
Command Connection properties - displays the connection properties of the opened project
Command Make Active - activates the current opened project

Command Exit - closes the configurator application

With this command you can start the new project. To start the project, select from the File menu

command New (the shortcut is Ctrl+N) or you can choose the button [ from the toolbar of
configurator.

Then you have to specify the new project database. SNMP OPC Server work with MS Access
database. In the following dialog, you have to define the destination and the name of this project
database.

Copyright © 2004-2013, SAE - Automation, s.r.o. (Ltd.), All rights reserved.



59 SAEAUT SNMP OPC Server™

2|
5 ave in:ll.f}SNMF' OPC Server j € 05 i

File narme: S P Con Save I
Save as tpper | Microsoft Access Databases [F.mdhb) j Cancel |

Figure: Dialog box - new configuration

2.4.6.1.2 Open

With this command you can open the stored project. To open existing project, select from the File

a
menu command Open (shortcut Ctrl+O) or you can choose the button L= | from the toolbar of
configurator.

After that you have to specify the database of the existing project.

open 21
Look in: | (2 SNMP OPC Server o F e E
@SNMPCDHF

File narme: || Open I
Filez af type: IMiErDSth Access Databazes (7 .mdb] j Cancel |

Figure: Dialog box - open configuration
2.4.6.1.3 Save as

The configurator allows you to save the project database to your hard drive. You can select from the

File menu command Save as, and than specify the name and the location of the project database. You
can define the name and the directory of the project database.
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saveas 21 x|
Save in; I ) SHMP DPC Server j ¢ ¥ (o M=
@SNMPCDHF

File narme: S P Con Save I
Save as tpper | Microsoft Access Databases [F.mdhb) j Cancel |

Figure: Dialog box - Save configuration as

2.4.6.1.4 Connection properties

From the File menu you can choose the command Connection properties. This will open a dialog,
where the state of the connection is displayed. There are the initialization properties for current
database connection of the opened project.

Database connection properties El

File name:
IE:'\WDrking Directan’,_othershSMMP OPC ServerhSkMPConf. mdb

Thesge are the initialization properties for cument databaze connection
[in alphabetical arder):

M ame Walue -
Data Source :\wforking Drir
Extended Properties

Jet OLEDB:Compact ‘Wwithout Replica Repair Falze

Jet OLEDEB:Create Systern Databaze Falze

Jet OLEDE:Databaze Locking Mode 1

Jet OLEDB:Database Pazsward

Jet OLEDEB:Don't Copy Locale on Compact Falze

Jet OLEDE:Encropt Database Falze

Jet OLEDE:Engine Type ]

Jet OLEDE:Global Bulk. Tranzactions 1

Jet OLEDE:Global Partial Bulk, Ops 2

Jet OLEDE:MNew Databasze Password

Jet OLEDE:Registy Path |-
Jet OLEDE:SFP Falze

Jet OLEDE:System databaze

Locals [dentifier 1033 -
J I ;IJ

Provider Mame, Yersion:

IMiu:n:usu:uft OLE DB Provider for Jet, 0400, 8227

Cloze |

Copyright © 2004-2013, SAE - Automation, s.r.o. (Ltd.), All rights reserved.



61 SAEAUT SNMP OPC Server™

Figure: Dialog box - Database connection properties

2.4.6.1.5 View server script

It enables to display all used JScript function used within a configuration with syntax highlight.

[

5 | Script viewer

-

(=] O |wSa)

PIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII
£ Script file for SAEAUT SHNMF OPC Server v
£ (c) 2004-2008 S54AE - Automation, =S.r.o. v
FAEFESFEFETET Tl i i i i iririririririfiris
S This iz automatically generated file, please J/
S/ do not edit! I
FAEFESFEFETET Tl i i i i iririririririfiris

FITTFF T T i i i iifiifiifiifiifiifrifiissy
S Global wariables

LTSS E S E S ST EE TS i Eiiiiiiiiiiiiiss

S Functions

// Item Random From 10 To 20 handler
function OnItemRead Random From 10 To 20()
i
var RetWVal;
var a=10;
var b=20;

EetVal=(a + Math.floor (Math.random()* (b—-a+1})))
return RetVal:
}

S Item JS5criptVersion handler
function OnItemRead JS5criptVersion()

o 4= CTererdrmtTroadmalMdinosiTlarodoan (6.

4| 1]

Figure: JScript viewer

i
wvar Ver = "You are using " 4+ ScriptEngine() + " Version
Ver += ScriptEngineMajorVersion() + ".";

b

m

Remark: before switching to another configuration, please, backup the file with JScript functions under
other name because all configurations use the script file with the same name.

2.4.6.1.6 Make Active

With this command, you activate the project database. The active database is the database that the
server will load when started. To activate the database, select command from the menu File>Make
Active. After that, the configurator will inform you about activation of the database.
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SNMPOpcServerConfigurator ﬂ

& Current active database is;
x,_*/ 'CilWorking Directory_otherstSNMP OPC ServeriSMMPConf, mdb',
Active database is the database that the server will load when started,

Currently edited database is:
"Cilarking Direckary!_akhersi SMNMP OPC ServeriSHMPCanf_new,mdb’,

Do wou want o set edited database as active database?

Yes Mo

Figure: Dialog box to activate configuration opened in configurator

When the current database is activated, the command Make active is disabled from the menu.

2.4.6.2 Edit menu

In this menu you find commands which can be used for editing the items in the list control - devices,
folders and data items. You can create new item, rename existing item, delete item. Then standard edit
function as Cut, Copy and Paste and also command for selection items are available there.

Mew 3
Renare Zkrl+R
Delete Zkrl+Del
Find Shift+F
Cut kel
Copy k|41
Select all Chrl+A

This commands are available in Edit menu:

New - creates a new item (device, folder, data item)

Rename - renames an existing item

Delete - deletes selected item

Find - allows you to search for text within the current configuration and then interactively
review matches.

Cut, Copy and Paste - standard clipboard functions

¢ Select all - this command selects all items

¢ Invert selection - this command invert the selection of items

2.4.6.2.1 New

With this command you can add a new device to the project, create a new folder for the existing device
or add a new data item.
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e Command Device - adds a new device in the project

e Command Folder - creates a new folder for the existing device

e Command Data Item - adds a new data item of the chosen device in the project

2.4.6.2.1.1 Device

With this command you can add the new device to the project. When in the tree view control of the
configurator (on the left panel), the folder Address space is highlighted, you can choose from the
menu Edit > New - Device (or the shortcut key Ctrl+D) or you can click with the right mouse button
on this folder and from the pop-up menu choose the command New - Device (or the shortcut key

Ctrl+D).
Mew
Remname Zhrl R
Delete Chrl e
il (o o ot
Copy (ZhrH-T
Faste Zhr Y
Select All Chrl+5
Irvert Seleckion

ﬁENMPEunf - SMNMPOpcServerConfigurator

File Edit %iew Go Tools Help

Figure: Opening of Device dialog view

#-{E] Conversion:
[#-{@] Simulation 5
[+1-{@a] Alarm Defini

Remanme
[

Delete

Zuk

Copy!
Easte

Large Icons
Small Icons
Lisk

* Details

F7
Fa
Fa
F10

Dialog wiew
Monibor wiew

11
Fiz

|

After that device dialog view will be opened.
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2.4.6.2.1.2 Folder

The configurator of SNMP OPC Server makes it possible to define folders for devices. You could
create your own folder structure and divide the data items into this folder structure.

With this command you can create new folder for the existing device in the project. When in the List
control of the configurator (on the left panel) the device is highlighted, than you can choose from the
menu Edit > New > Folder (or the shortcut key Ctrl+F) or you can click with the right mouse button
on the device and from the pop-up menu choose the command New > Folder (or the shortcut key

Ctrl+F).
[lew
ks Folder Ckrl+F
Rename Ckrl+R, Data Ikem Chrl+I
Mulkipls. .. kvl
Delete Ckrl+Del
Cuk Chel43
Copy Chel4+C
Faste ZhEl
Select Al (g e et
Irert Seleckion

SNMPEunf - sNMPOpcseryerConfigurator

File Edit “ew Go Tools Help

D@ | BEeE=E] % B R %
E’g Address Space | Mame | simulate | Data-

{77 T Folder  Ctri+F
Conversio Data Ttem Chri+1
@] Simulation  Rename

-- Alarm Defi Mulkiply,..

Delete
Cut I arne; IN ewlevice
Copy

Paste [dl:lress: |12?.EI.EI.'I

L I F7 . -

arge fons ity Ipul:ullc

amall Icons  F&

Lisk Fa
* Details Fi0

Connection settings

Connection time-ot; F
v Dialog wiew  F11

Monitor view F12 Murnber of retries: E

Figure: Opening of Folder dialog view

After this you have to specify the name of the folder in the folder setting dialog,

2.4.6.2.1.3 Trap

This way a special trap folder for OPC items that can be updated according to SNMP varbind that is
received within trap can be created.
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" SNMPConf - SNMPOpcServerConfigurator
File View Go Tools Help

D New ’ Folder Ctri+F
4 E -
= ; D Ctrl=R Trap ype lnccﬁs Rig... | Use trap ]
= Data ltern Ctrl+1
Delete Ctrl+Del
Find Shift+F
BE con Ctrl+X
B2 .
.= Copy Ctrl+C  3NMPagentDevice
=d Past Ctrl+V
+ o ' 27.0.01 ]
Select All Ctrl+A
) lic: [V Managed device
Invert Selection
Conr ljngs
Connection time-out: {1000 ms LhE;';B“:“:'UthF'?ﬂ“EtEftis
oubled each time a retry
Murnber of retries: |3 attempt is transmitted,

| | AddNew |

Figure: Opening of Trap dialog view

Remark: to be able receive TRAP with related SNMP varbind the SNMP agent of the device has to
provide it. The best practice is to let create trap folders automatically by creating OPC items using off
line browsing from device MIB file.

2.4.6.2.1.4 Data ltem

With this command you can add the data item into the device in the project. When in the List control of
the configurator (on the left panel) an option device is highlighted, than you can choose from the menu
Edit > New - Data Item (or the shortcut key Ctrl+I) or you can click with the right mouse button on
the device and from the pop-up menu choose the command New - Data Item (or the shortcut key
Ctrl+l).
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" SNMPConf - SNMPOpcServerConfigurator

File _ View Go Tools Help

0O New > Folder Ctrl+F
+{ E =
= : Rename CtrisR Trap ype lﬁ.ccﬁs Rig... | Use trag
= Data ltemn Ctrl+]
Delete Ctrl+Del
Find Shift+F
BE o Ctrl+X
B .
o @ Copy Ctrl+C  jNMPigentDevice
o Past Ctrl+V
B o ' 27001 =
Select All Ctrl+A
) lic ¥ Managed device
Invert Selection
Conr lings
Connection time-out: |IEII:IEI ms LhegﬁﬂUthD?'mEtEftis
oubled each time a retry
Murmber of retries: |3 attempl is transmitted,
| AgdNew |

Figure: Opening of Data item dialog view.

2.4.6.2.2 Rename

With this command you can rename the devices and data items. First you have to select in the list
control the item you want to rename and then you have to choose the command from the
Edit->Rename, or by the right mouse click on the item and than Rename from the pop-up menu (you

can also use the shortcut Ctrl+R).

At first, choose the item you want to rename from the list box (it could be, device, folder or data item)

=48 Address Space
- E-{l] MewDevice
f RN ricDat altem
Conversions

{E Simulation Signals
&-{@a] Alarm Defiitions

Then right-mouse click on the item or from the menu

Copyright © 2004-2013, SAE - Automation, s.r.o. (Ltd.), All rights reserved.



67 SAEAUT SNMP OPC Server™

MNew 3
Rename
Mulkiply, .,
Delete

Mew 3
Cuk
Cu Rename Cke|+R
=Y Mulkiply. . ChrbM
FPaste

Delete Zkrl+Del
Large [cons  E
amall Icons B8 Cuk Chel+3
List Fa Copy Chel+C
Details F10 Faste ZhEl -

v Dialog wiew  Fil Select All Chrl+8,

Monitor wiew FL1Z Inwvert Selection

Now you can change the name of the selected item

=48 Address Space

- E-{l] MewDevice

o EwitchStatus
-- Conversions

{E Simulation Signals
-- &larm Definitions

2.4.6.2.3 Delete

With this command, you can delete the items (device, folder or data item) from the configuration. At
first you have to select the item you want delete and than you choose from the menu command
Edit>Delete, or by right-mouse click you display the pop-up menu and from this menu you chose
delete (or you simply push the Delete button on your keyboard, or shortcut Ctrl+Delete).

At first select the item you want to delete.

El'g Address Space
: E||'|f_| MewDevice

onversions
- {@] Sirulation Signals
[+1-{@a] Alarm Definitions

Then from the menu or from the pop-up, choose the command Delete
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MNew

Rename
Mulkiply, .,

Cuk

Copy

FPaste

Large Icons  F7

Small Icons  Fa

Lisk Fa
* Details Fi0
v Dialog wiew Fl1

Monitor wiew Flz2

Mew

Rename Cke|+R
Mulkipls. .. kvl

Chrl+Del

Cuk Chel+3
Copy Chel+C
Faste ZhEl -
Select All Chrl+a

Irert Seleckion

After that you have to confirm your option to delete the item in the following dialog

SMNMPOpcServerConfigurator

J{) Are you sure wol wank ko deleke Data Item "1 Address SpaceiMewDevice! SwitchSkatus'?

]

2.4.6.2.4 Find

The Find dialog box allows you to search for text within the current configuration and then interactively
review matches. You can access the Find dialog box by choosing Find on the Edit menu, choosing the
loupe icon on toolbal or through hot key Shift+F.

To display Find dialog box click on menu-item Edit = Find or toolbar-item Find.

MNew
Renarne

Delete

Find Shifk+F

Cuk
Copy

Select Al

Chrl+-R

Chrl+Doel

Chrl+i
Chrl4+C

Chri4-A
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LJ
&

[E1 4 B

EFENEIEY
F

click on the Find item

Figure: The Find dialog box in the application menu and toolbar.

You can see the Find dialog box as it is shown on the following figures.

| v
Loak in:
|Entire Configurakion w |

[ ]ratch case [ ]match whole word

Find what; Find Al
136121150 v |

Loak in:

|Entire Configurakion w |

[ ]ratch case [ ]match whole word

Figure: Two examples of the Find dialog box.

The Find dialog box provides several standard search options to help you improve the accuracy of your
search. It allows you to search entire configuration or only part of configuration.

Find what
Enter the text for which you intend to search. Select the drop-down list to display the last 10 items
entered.

Look in
It allows you to search for in entire configuration or only in part of configuration. You can select a pre-
defined scope from the drop-down list. These scopes include Entire Configuration, Data Items and
Script Items.

Match case
When selected, the search operation looks only for occurrences that match the uppercase and
lowercase characters you enter in the Find what box.
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Match whole word
When selected, the search operation looks only for occurrences that match whole words.

All Find results are always displayed in the Find Results tab, which is included in Output View. The
Find Results provides a list of all occurrences of the specific text within the current configuration and
then interactively review matches.

Note that: The Find Results tab allows you to review each individual search
occurrences directly in the main Tree view and also the item details in
Dialog view.

To review individual search occurrences please Double Click on an item directly in Find
Results. Then, the item details will be shown as in the figure below.

SHMPConf - SMMPOpcServerConfigurator E|@|g|

A Bl Wew €@ s o 3. You can see the item detail in
O = £ gt 4, B the dialog view.
=-+8 Address Space e A~
= HE MewDevice ;'E'ﬁ Mame: |sysUpTime_D |_|:| Heartbeat
=1 mib_z
=2 system Dezcription: | |
[ sysDescr [tem properties [ Simulate
2 syshame . Signal
. gnal:
=120 syslpTime Ble 08
| S |1361.21.1.30 | I Manal
[+ {57 Copversion Diata type: | Value: |
. . Timeticks v
2. You can see the item in !
the tree view. (%) Read only ) ReadMwiite [ Use corversion
[] Matification [Use SWMP Trap] Name:
[ Use script
L%

Find all "sys" in Entire Configuration

Data Items ...
Address Space/Newlevice/mib 2/systemfsysDescrfsysDescr [u}

Address Space/Newbevice/mib Z, Shid UpT itne sUpTime 0O
iddress Space/NewDevice/mib ZISystemfsysNamEfsysN,wﬁ:.‘D

Seript Items ...

1. Please double-click on a reported item.
3 occurrence (s) have been found.

Q Find Fiesults |
Ready ML

Figure: The Find Results tab and review of individual items in associated views.

See Also
Find

2.4.6.2.4.1 Find Results
All Find results are always displayed in the Find Results tab, which is included in Output View. The

Find Results provides a list of all occurrences of the specific text within the current configuration and
then interactively review matches.
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Note that: The Find Results tab allows you to review each individual search
occurrences directly in the main Tree view and also the item details in
Dialog view.

To review individual search occurrences please Double Click on an item directly in Find
Results. Then, the item details will be shown as in the figure below.

B SNMPConf - SHMPOpcServerConfigurator,
File Edit Wew Go Tools Help

0O = E & B

3. You can see the item detail in
the dialog view.

[ A4 B

=2 Address Space __4___ =
— :
= Ti] MewDevice Mame: |s_l,lsUpTime_D |—|:| Heartheat
=23 mib_2
=1 system Description: | |
[0 sysDescr [bem properties [ Simulate

2 syshame

=23 sysUipTime Ohiect I0: Signal:
syslpTime_0 |.1 36121130 | [THand )
- Diata ype: | Value: |
- . Timeticks v
2. You can see the item in :
the tree view. (%) Read only ) RieadMwrite [] Use conversion
] Notification [Use SHMP Trap) Mare:
[T Use script

Find all "sy=" in Entire Configuration

Data Items ...
Address Space/NewDevice/mib 2/system/sysDescr/sysDescr O

= Space/Nevlhevice/mib Z/=aystem/sysUpTime/sy=sUpTime O
Lddress Space/Newlevice/mib_ 2/system/sysName/ s?stﬂ
Soript Items ...

1. Please double-click on a reported item.
3 oecurrence (3) have been found.

Q Find Results |
Ready TIIM

Figure: The Find Results tab and review of individual items in associated views.

See Also
Find

2.4.6.3 View menu

Commands in this menu provide the possibility to change the view of the configurator due to user's
requirements. You can display two types of toolbars, than turn-on or turn-off the status bar, change the
item presentation in detail view
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Toolbars b
v Skakus Bar
Large Icons F7
amall Icons Fa
Lisk F9
* Details Fi0
v Dialog wiew Fii
v Monitar view Flz
Sork by 2
Show/hide columns r
Select Languade. ..
Global Refresh FS
Subtree Refresh  Chrl+FS

Figure: View menu

Toolbars - hides or shows the Standard toolbar and Data manipulation toolbar

e Status bar - hides or shows the Status bar
¢ Next group of commands Large Icons, Small Icons, List and Details - change the look of the

Details table

¢ Dialog view - hides or shows Dialog View
e Monitor view - starts or stops the internal OPC client application and shows or hides the

Monitor view

Sort by, Show/Hide columns - these commands enable sorting in Details and show or hide
columns

Select language - here you can select the language of the application

¢ Global Refresh - makes global refresh of the whole Item list control
e Subtree Refresh - makes refresh of some part of Item list control

2.4.6.4 Go menu

Commands in this menu item allow user to move through the Item list control.

Back. Chrl+Al+Left Arrawve
Forward hr - AlEHRight Ao
Up One Level

Mext Ikem Bl +Doaim Ao

Previous Ikem

Alk+Up Arrow

Expand Item  Alk+Left Arrow
Collapse Ikem  Alk+Right Arrow
Page Up alt+Pglp

Page Down alk+Pgln

Home Alt+Home

End Alt+End

Mexk Pane Fé&

Previous Pane  Shift+Fé

Copyright © 2004-2013, SAE - Automation, s.r.o. (Ltd.), All rights reserved.



73 SAEAUT SNMP OPC Server™

With these commands you can go through the items

Back - moves one step back

Forward - moves one step forward

Up One level - moves from item to its parent item
Next Item - moves to the next item

Previous Item - moves to the previous item
Expand Item - expands device or folder item
Collapse Item - collapses device or folder item
Page Up - moves one page up

Page Down - moves one page down

Home - moves at the beginning of the list

End - moves at the end of the list

Next Pane - moves to the next dialogs pane
Previous Pane - moves to the previous dialog pane

2.4.6.5 Tools menu

In this menu you can find some special tools of the SNMP OPC Server.

Qptions...
IP Seanner
View Log Files :

Compact/Repair Configuration Database...

Genetic Algonthm MNet Wizard

2.4.6.5.1 Options

This dialog view enables setting of different options for configurator in sections :

o Workspace settings
e Monitor view settings

and for SNMP OPC Server Runtime in sections:
e Log the SAEAUT SNMP OPC Server activity
e OPC Server settings
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Options £
General |

Workspace settings
[+ Save regional settings in registry
[ Automatically apply changes when selection is changed

[ Enable hover selection. Hover Time: 500 [ms]

Manitor view settings

Update Rate: 500 [ms]

| Logthe SAEAUT SNMP QOPC Server activity

| |

u u

-

Maxdmal number of log files: 10 -

Maximal log file size: 10 T | [MB]

QPC Server settings
[ Show properties when browsing

QK Cancel

Figure: Dialog box Options
Workspace settings

Save regional settings in registry
enables/disables the configurator to save active language chosen from the Select Language
dialog into registry and set it up during initialization (not used in this version)

Automatically apply changes when selection is changed.

If checked, the configurator itself tries to update the edited data without requiring to click on
Apply button, and displaying the confirmation dialog.
Enable hover selection, Hover time

all configurator support automatic selection of the item above which the mouse is hovering.
Enter Hover time parameter in milliseconds.

Monitor view settings
Update rate
specifies the update frequency of Monitor View items.

Log the SAEAUT SNMP Server activity

If not checked then by start of the OPC Server runtime only head with system information is written
to log file

If checked then all information generated in the regime LOG_ALWAYS is written to the log file

SNMP Operations
Results of all GET and SET SNMP Operations
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SNMP TRAPs

Errors by SNMP Traps receiving
Update Time

Time for scanning of every connected device
Java Script errors

Errors by processing of JScript functions
Basic information

Associating of OIDs to OPC items required by an OPC client

Maximal number of log files

Maximal number of log files that creates SNMP OPC server in the log directory.

Maximal log file size [MB]

When the OPC server runtime is started and running, information is added to an log file till it has
defined max. size. After that, the new file is created (in case that less than maximal number of files

is in the log file directory).

OPC Server settings
Show properties when browsing

if checked OPC clients will be able browse not only OPC items but also their properties in the

address space of the OPC server.

2.4.6.5.2 IP Scanner

IP Scanner enables to scan the network in given range and find connected SNMP devices.

IP Scanner
IP Address Range
From: | 192 . 166 . 16 . 0 | To: | 192 . 186 . 2 . 0 |

Commuriby: | public Fing timeout [ms]: | 20 Port: | 161

(1 5can onby Far active SUMP devices with the given community

(¥} Scan For all devices available an netwark:

Fevzilable devices Final kst of IF Addresses:
19Z.1658.16.19 192.166.16.45

192.163.16.43 152.168.16.90

192, 164.16.53

192, 168.16.60

192, 165.16.50

192,168 16.595

192.164.16.597

Sedeck 41

Scanned IP: .. T | e
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Please see about |P scanning also in the "How to"

2.4.6.5.3 View Log Files

It enables view all log files in log file directory. Log files are created according to defined options.

Log files | =2 |
File Name | Date Size - Close
Log_07_20131022151915. bt 10/22/13 15:13:15 5463 Bytes
Log_01_20131003154033. txt 10/03/13 15:40:33 6658 Bytes =
Log_01_20131003092851. tut 10/03/13 09:23:51 3328 Bytes

Log_01_20130925104418. bxt 09/26/13 10:44: 15 4992 Bytes

Log_01_20130925143542. txt 09/25/13 14:35:42 16640 Bytes

Log_01_20130917155805. txt 09/17/13 15:58:05 31616 Bytes

loa 01 20130916160936. et NaM6M3 16:09:36 7378 Rutes S
File name: Log_07_20131022151915. txt Files: a

Directory: C:\Users\palacka\Documents\SAEALT_SMMP_OPC_Server|LOGY

COMPUTER NAME : SRE32 =
OPERATING SYSTEM 1
Platform : Windows 7
Version HE P

: Service Pack 1
{Build 7&01)

Service pack
Build numker
MEMORY INFORMATION

TotalFPhys : 2047 MB, RAvailFhys : 962 MB
TotalPageFile : 40895 MB, RAvailPageFile : 3166 MB
TotalVirtual : 2047 MB, RAvailWVirtual =: 1960 MB
FRODUCT
Hame : SAEROT SNMP OBC Serwver
ProgID : SAFRutomation.SHNMPOpcServerDA.3
OPC compliance : OPC Data Access 3.0, OPC Data Access 2.0 and OFC Data Access 1.0
Version 1 3.02.00
Company name : 5AF - Rutomation, S.r.o.
Copyright : Copyright @ 2004-2012 5AE - RAutomation, s.r.o. A1l rights reserved.

Modul file name : Ci\Program Files\SAEAUT SHMF OPC Server)\SHMPRuntime.exe

Basic informations : No -

Figure: Log files viewer.

2.4.6.5.4 Compact / Repair Configuration database

In this dialog box you can check your connected active configuration database for the errors and repair
it. Or you can check some other configuration database. The following dialog will display after
command Compact/Repair Configuration Database...
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2.4.6.6

Compact,/Repair M5 Access Database il

— Compact/Repair

¥ Connected Configuration D atabaze
" Other Database

| |

[=zer name; I.-’-'-.u:lmin

Fasswand: |

¥ | Uze blank password

¥ Backup onginal database before compacting starts
[recommended]

{B‘ b ake sure that all uzers are dizsconnected from the database
before the compacting/repainng procedure starts.

] I Canicel

Figure: Dialog box to compact/repair configuration database.

Help menu

Here can be found information about the software application, and also command for displaying this
help file.

Help Topics

About Application. .

About Application dialog...

SAEAUT SNMP OPC Server Configurator, Professional ==

Copyright 2 2004-2012 SAE - Automation, s.r.o.
Trencianska 13

018 51 Mova Dubnica, Slovak Republic
vy zaeautom. sk, zae-automation{@sasautanm, sk

Vi
¢
n

B

UTOMATION, .50,

anwe ] SAEAUT SHMP OPC Server 3.02.00
._ Server vergion: 3.02.00

Configurator wersion;  3.02.00

How to

To work with SAEAUT SNMP OPC Server, you will need an OPC client application. Probably, you have
an own application with OPC client interface for example a SCADA system. However to start working
with SAEAUT SNMP OPC Server runtime, you can use monitor view of the SAEAUT SNMP OPC
Server configurator as described in the chapter , The first start of SAEAUT SNMP OPC Server".
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Within the SAEAUT SNMP OPC Server product package, you can find and install a few OPC client
applications (as described in , Installed software and examples"):

e OPC DA and XML DA OPC Client - it is necessary to install OPC client itself and also to
install configure and start XML DA wrapper to experiment with OPC DA and
OPC XML DA interface.

e OPC UA client — it is installed from installation package common with OPC UA wrapper. After
starting OPC UA wrapper you can use it to test OPC UA interface.

e OPC DA client projects with source codes — to experiment with them you will need to compile
them using proper version of the Microsoft Visual Studio.

Useful possibility to watch changing values of MIB variables also in graphics offers OPC DA client
application — OPCAdapter (not delivered with installation package, but demo version can be
downloaded cost free).

Using above mentioned OPC client applications you will be able to start SNMP OPC server running
with delivered demo configuration immediately. To adapt SNMP OPC server functionality to your
needs, you will need to create your own configuration. Methods for creating of configurations are
described in the chapter ,Methods how to configure SAEAUT SNMP OPC Server effectively".

If you configure MIB OIDs for your OPC items by hand, there is useful possibility to test their
correctness using SNMP GET and SET commands directly from configurator.

To gain first experiences, we suggest trying to use standard SNMP agent running on Windows
operating systems. Using on line MIB browsing, you will be able to import hundreds of MIB variables
offered by this agent to the OPC server address space. For the first experiments, also delivered
SAEAUT SNMP Agent is very useful. It is delivered with own demo configuration and you can add its
functionality also to your application easily using on line MIB browsing. SAEAUT SNMP Agent can be
used e.g. to learn working with SNMP TRAPS.

3.1  Methods how to configure SAEAUT SNMP OPC Server effectively

Possibilities and methods how to configure address space of
SAEAUT SNMP OPC Server from version 2.09 effectively

Introduction

Manual configuration of the address space of SNMP OPC Server can be, for many SNMP
variables and many SNMP devices, really time consuming. The SAEAUT SNMP OPC Server
provides various methods how to create configurations easy, effective and really fast. At the
time of creation of a configuration, you can use single or even combination of the following
methods:

On-line browsing.

Import from MIB files (Off-line browsing).
Import from CSV files.

Export to CSV files.

Import from XML files.

Manual configuration.
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On-line browsing

If we have a possibility to connect SNMP devices which we would like to monitor or control
then we can use a method called On-line browsing for searching of all available SNMP
variables directly from connected devices. Using this simple method, we can transfer on one-
click not only one SNMP variable but even entire tree multi-level hierarchical structure to
address space of SAEAUT SNMP OPC Server. Advantage of this method is that all obtained
SNMP variables are really defined in device and in time of monitoring and controlling of
device will be definitely available. Small disadvantage of this method is a limited volume of
the information transferred about SNMP variables from the device. It means, we cannot
obtain for instance description of a SNMP variable this way. Of course, all important
parameters for functionality are available.

To enable the On-Line browsing in the SAEAUT SNMP OPC Server Configurator, please do
the following:

Create a new device or select an existing device.

Right-click on the device and choose MIB Browse (On-line) (see Figure 1).
Click on the Load MIB (On-line) button (see Figure 2).

Select the SNMP variables of folder in the tree.

Click on the Transfer object(s) to configuration button (see Figure 2).
Click on the Close button.

The SNMP variables mapped to OPC items (see Figure 3).
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Figure 1: The MIB Browse (On-line): The start from the device menu.
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Figure 2: The MIB Browse (On-line): The tree structure of available SNMP variables from
connected device.
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Figure 3: The MIB Browse (On-line): The SNMP variables transferred to OPC items.

Import from MIB file

We need very often to prepare a configuration although we have no available SNMP device
yet. In this case, we can use one of the following methods: Import from MIB file or Import
from CSV file.
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A MIB file is a text file which enables to organize SNMP variables in well-known tree
structure. The MIB file provides complex information about available SNMP variables (i.e.
description of SNMP variable). The MIB file can even include references to other MIB files
and then the content of these MIB files can be also included. The number of defined SNMP
variables in one MIB file can be large and different for each device type. Therefore, the
SAEAUT SNMP OPC Server configurator brings possibility of Off-line browsing for searching
of SNMP variables directly from MIB files. Using this simple method, we can transfer not only
one SNMP variable but even entire tree multi-level hierarchical structure to address space of
SAEAUT SNMP OPC Server on one-click. A small disadvantage of this method is that not all
SNMP variables defined in the MIB file have to be available in a specific SNMP device type.

To enable the Off-Line browsing (Import MIB file) in the SAEAUT SNMP OPC Server
Configurator, please do the following:

Create a new device or select an existing device.

Right-click on the device and choose MIB Browse (Off-line) (see Figure 4).
Click on the Load MIB (Off-line) button (see Figure 5).

Select the SNMP variables of folder in the tree.

Click on the Transfer object(s) to configuration button (see Figure 5).

Click on the Close button.

The SNMP variables mapped to OPC items (see Figure 6).
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Figure 4: The MIB Browse (Off-line): The start from the device menu.
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Dievice
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Close

Figure 5: The MIB Browse (Off-line): The tree structure of available SNMP variables from

MIB file.
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Figure 6: The MIB Browse (Off-line): The SNMP variables transferred to OPC items.

Import from CSV file

The CSV file is also textl file which structure is very similar to tables. The SNMP variable in
the MIB file is presented as one row and its individual parameters (e.g. name or OID) are
columns separated by comma or semi-colon. Each SNMP variable starts at the new line
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(CR+LF) of CSV file. The CSV files are created e.g. by providers of devices or by
integrators. Import of SNMP variables from CSV files to SAEAUT SNMP OPC Server is fast
and easy (on one-click). As a small disadvantage of this method can be perceived that
SNMP variables are not organized in a tree hierarchical structure. But, this feature is not
important for functionality because it defines only logic "virtual" organization of the items.

To enable the Import from CSV file in the SAEAUT SNMP OPC Server Configurator, please
do the following:

Create a new device or select an existing device.

Right-click on the device and choose Import from CSV (see Figure 7).
Select the CSV file definition in the combo-box (see Figure 8).

Click on the OK button (see Figure 8).

The SNMP variables mapped to OPC items (see Figure 9).
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Figure 7: Import from CSV: The start from the device menu.
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Figure 8: Import from CSV: The dialog displays the list of available devices for which are
defined CSV files.
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Figure 9: Import from CSV: The SNMP variables transferred to OPC items.

Export to CSV file

The SAEAUT SNMP OPC Server Configurator enables to export SNMP items from the open
configuration to a CSV file. The CSV file is possible to create on the level of devices. It
means that for each device, from the configuration, it is possible to store all relevant SNMP
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items to one CSV file. The structure of the CSV file is the same as it was already described
in the section "Import from CSV file". The same CSV file structure gives possibility of data
transfer between defined devices and even between various configurations. A little
disadvantage of this data transfer is that during exporting data to CSV file can be changed
data structure from tree to flat structure. But, this structure is not important for functionality
because it defines only logic "virtual" organization of the items. If you want to copy SNMP
items between different devices or configurations then we recommend to you use as a
destination folder for your CSV file the following application folder .\SAEAUT SNMP OPC
Server\CSWV\

Note that: If you want to copy SNMP items from one device to another device in the same
configuration then using functionality "Copy" and "Past" is more effective. In addition, in this
case the structure of transferred data is unchanged.

To enable the Export to CSV file in the SAEAUT SNMP OPC Server Configurator, please do
the following:

1. Create a new device or select an existing device.

2. Right-click on the device and choose Export to CSV (see Figure 10).

3. Select the destination folder. It is recommended to use the application folder
.ASAEAUT SNMP OPC Server\CSV\ (see Figure 11).

4. Write the CSV file name.

5. Click on the Save button (see Figure 11).
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Figure 10: Export to CSV: The start from the device menu.
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Figure 11: Export to CSV: The start from the device menu.

Import from XML file

The SAEAUT SNMP OPC Server provides also another possibility how to configurate
address space. The configuration of the SAEAUT SNMP OPC Server is stored in the
Microsoft Access MDB file. There is possibility in the configurator tool to export entire
configuration to a XML file. This XML file can be modified in an arbitrary xml or text editor
and imported to a configuration of SAEAUT SNMP OPC Server.

To enable the Import from XML file in the SAEAUT SNMP OPC Server Configurator, please
do the following:

1. Click on the File = XML Import... (see Figure 12).
2. Select a XML file.
3. Click on OK button.
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Figure 12: Import from XML: The start from application menu.
Manual configuration of OPC item

The SAEAUT SNMP OPC Server enableses also a manual creation of configuration. You
can set manually all parameters of OPC item. Between the most important parameters
belong following:

Name.

Description.

Object OID (associated to SNMP variable).
Data Type.

Access Rights.

SNMP Trap natification.

Etc.

To enable the manual configuration of OPC item in the SAEAUT SNMP OPC Server
Configurator, please do the following:

1. Create a new or select existing OPC item (see Figure 13).
2. Set the required parameters.
3. Click on the Apply button.
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Figure 13: Manual configuration: The dialog for manual configuration of an OPC item.

Related articles

How to browse available SNMP variables?

MIB Browser (On-Line) - browsing SNMP variables from a connected Device

MIB Browser (Off-Line) - browsing SNMP variables a MIB file that describe Device

3.1.1 IP Scanner

To open IP Scanner choose Tools f IP Scanner from main menu.

Copyright © 2004-2013, SAE - Automation, s.r.o. (Ltd.), All rights reserved.




89

SAEAUT SNMP OPC Server™

IP Scanner enables to scan the network in given range and find connected SNMP devices.

(P Scanner |

~IP Address Rarge

From: [(182 . 168 . 16 . 0 | o [192 168, @ .0 | [ s ]
Communty: Bl | Pigtmecitinsk (28 pot: 161

(_¥5ean only Far active SHMP deviees with the given cammunity
{#)5ean For Al devicas availsble an netwark

scanned IF ... o] [Lene

After scanning, IP addresses of all found and selected devices are visible on Device panel. To set the
IP address of device, just select the address from the list.

S doubled each bme & relry
Mumber cfreties: (3| altamps is bianzmitted.

How to use IP scanner?

First you need to set scanning parameters :
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3.1.2

IP Range
Community
Ping timeout
Port

As default values are used public community, ping timeout = 20ms and standard SNMP port 161.

Than, choose what type of devices do you want to scanning for:

) Scan onky For active SHMP devicas with the ghven commmunity
(%) Scan For all devices avallable on network

- You can choose to scan only for active SNMP devices with the given community.
- The second possibility, scanner will find all devices connected to network and not only
SNMP devices. In this case, the given community is ignored.

Now you can press = and start the scanning. Bottom left is displayed the currently scanned IP
address. The scanning you can stop at every moment with button 2.

The list left contains the currently scanned and found IP addresses. This list is always cleared after you
press Scan. The list box right contains the final list of IP addresses. This is the list what you can see on
device panel. You must manually create this list with moving the addresses from the left list to this final

list. To learn to work with this lists read following notes :
- First you need to select the addresses and than you can operate with them (move or

delete)
- To select more items hold <Ctrl> or <Shift> and use mouse button or standard arrow keys

- To select all IP addresses click to the list and press |-==etal_]
- To move the selected addresses from the left list to the final list, press 2= 222 )
- To delete selected devices press (_Gciete |

Final, you need to confirm the changes pressing , or cancel it with .

MIB Browser (On-Line) - browsing SNMP variables from a connected Device

In order to know desired object MIB Objects, the SAEAUT SNMP OPC Server™ implements the MIB
Browser (On-Line), whose task is to request a SNMP device for its object identifiers (OID) of all the
variables that can consecutively be used.

On-Line MIB browsing can be invoked on a device specified directly in the Address Space of SNMP
OPC Server Configurator where settings are overtaken from this configuration. By right-clicking on a
wished device, user chooses the MIB Browser (On-Line) entry from a popup menu.
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Figure A: MIB Browser (On-Line), open dialog.

MIB Browser is implemented as a new dialog window. It contains controls filled with Name, IP address
and Community values of device going to be browsed. There is an edit control containing the Default
object ID from which the device is started to be browsed. Its value can be changed according to the
user needs. By clicking the Load MIB (On-Line) button, user invokes browsing of device from the
specified Default Object ID.
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bmes,
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Figure B: MIB Browser (On-Line) dialog.

Browsed MIB Objects are logically structured and displayed in a tree view. They contain object ID
(OID), value and data type (Syntax) associated with each of them.
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Figure C: MIB Browser (On-Line) shows all available SNMP variables from localhost computer.

The items listed in the tree view can be added into the configuration of SAEAUT SNMP OPC Server™
keeping the level structure specified by browsing. SAEAUT SNMP OPC Server™ takes over the
Name of the variable, its object ID (OID) and data type (Syntax).

Because Access rights of particular variables are not SNMP attributes receivable from the device,
these rights are defaultly set to Read-Only. It is user's task to change these access rights and user
responsibility for misusing them. Because of, the Name of the variable read from device can contain
dot characters and such names are not allowed to be used in SAEAUT SNMP OPC Server™ , when
transfering in the database all the dots characters in the names are replaced by underline characters.

User can add specified items into SAEAUT SNMP OPC Server™ configuration one by one or a group
of them at once by selecting wished item or folder in the tree view and clicking Tranfer object(s) to
configuration button. When choosing the folder, all the subfolders and items are added into
configurator database keeping the structure created by browsing.

Description of dialog controls

Copyright © 2004-2013, SAE - Automation, s.r.o. (Ltd.), All rights reserved.




93

SAEAUT SNMP OPC Server™

3.1.3

Control Name
Load MIB (On-Line)

Transfer object(s) to configuration

Close
Name
Community

IP address
Default OID

OID

Syntax
Derived
Value
Access
Status
Description

Related articles

Control Type
Button

Button

Button
static-box (Read-only)
static-box (Read-only)

static-box (Read-only)
edit-box (Writable)

static-box (Read-only)
static-box (Read-only)
static-box (Read-only)
static-box (Read-only)
static-box (Read-only)
static-box (Read-only)
static-box (Read-only)

Description

The button starts browsing of MIB
Objects from device.

Transfering MIB object (s) to
configuration database of SAEAUT
SNMP OPC Server™ . It is possible
to choose a single item or multiple
items at once. When choosing the
folder, all the subfolders and items
are added into configurator
database keeping the structure
created by browsing.

Close dialog.

Symbolic device name.

SNMP community name to which
belongs items.
IP Address of Device.

The object identifier from which will
start browsing items.
Identifier of MIB Object.

Syntax of MIB Object.
NA

Value of MIB Object.
NA

NA

NA

MIB Browser (Off-Line) - browsing SNMP variables a MIB file that describe Device

How to browse available SNMP variables?

MIB Browser (Off-Line) - browsing SNMP variables a MIB file that describe

Device

In order to know desired object MIB Objects, the SAEAUT SNMP OPC Server™ implements the MIB
Browser (Off-Line), whose task is to load all SNMP variables from a MIB file that is provided for a
device or computer. All object identifiers (OID) of all the variables can consecutively be used.

Off-Line MIB browsing can be invoked on a device specified directly in the Address Space of SNMP
OPC Server Configurator where settings are overtaken from this configuration. By right-clicking on a
wished device, user chooses the MIB Browser (Off-Line) entry from a popup menu.
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B8 SHMPConf - SHMPOpcServerConfigurator
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Details
Dighog wiew
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MIB Browse (On-Line)
MIB Browse (OFF-Line)

0 Object(s)

Figure A: MIB Browser (Off-Line), open dialog.

MIB Browser is implemented as a new dialog window. It contains controls filled with Name, IP address
and Community values of device going to be browsed. There is an edit control containing the Default
object ID from which the device is started to be browsed. Its value can be changed according to the
user needs. By clicking the Load MIB (On-Line) button, user invokes browsing of device from the
specified Default Object ID.

I Browser - Load data from device [OMN-LINE) El
SNIF MIB [objects) Device:
Hama: localbhcst Commurity: | public
P address;  1ZT.000.L

Disfad OO0 . L3E

Load MIB (0n-Ling)

Oiject

oI

Synibanc Do
Wakar:

ALRRS!

Status:

Cisscriphion:

Hiowy ko transfer obaects to the SSEAUT SNMP OPC Server configuration?
e
The MI8 Ohjects lsted in the SHMP BIM can be transfered inbo YOUR SAESUIT SNMP OFC Server configurabion
lzepireg the level structure specifisd by browsing,
To transfer an ohiects or srkre branches of objscts please salsct them vis & mooss left-bokton

obgect, mulbple
and chek on the “Transfer object{s) to configuration” Butbon, The button is possibl: bo use anough several
bmes,

Copyright © 2004-2013, SAE - Automation, s.r.o. (Ltd.), All rights reserved.



95 SAEAUT SNMP OPC Server™

Figure B: MIB Browser (Off-Line) dialog.

Browsed MIB Objects are logically structured and displayed in a tree view. They contain object ID
(OID), value and data type (Syntax) associated with each of them.

MR Browser - Load data from M file [DFF-LIME)
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= [ nkernek MIBPath:  COUWINDOWS system X2 hostab. mb Load MIB (CFF-Ling)
) drectory
= ) mgni it
=4 E"e , ol 126 0.2.0.1.10
= system

wi FEET Syntme; | SN_OCTETSTRING e

b sysObjectlD

£| s lpTims Wakie:

b sysContact e

b spshame [ -

b sysocabon Status: MANDATORY

) sysservices

= 1) inberfaces Diescriphion: | 4 teodual descoription of the enbity, This valus -~
[ Fhumber ool inchack Eha Full name and version
= | ¥Table iderkFication of the system's hardwars bvps,

= () WErkry sof g operating-systen, and networking 3
ﬂ Findex
B Frusscr
,_m ¥Typs How bo transfer cbescts bo the SREALIT SMMP ORC Server configurstion?
1] ¥y e |
1] ¥Speed
il FPhysaddr
'—"]ﬂd’: M’“ The MI8 Oitjects bsted i the SHMP BIM can be transfered int YOUR SAEALIT SNMP OFC Server configurabion
ﬂ P "H = ke bhs vl structure specifisd by browsing,

A T s
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U] FiricastPits e
P FIrdd emekits st
< *
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Figure C: MIB Browser (On-Line) shows all available SNMP variables from localhost computer.

The items listed in the tree view can be added into the configuration of SAEAUT SNMP OPC Server™
keeping the level structure specified by browsing. SAEAUT SNMP OPC Server™ takes over the
Name of the variable, its object ID (OID) and data type (Syntax).

Because of, the Name of the variable read from device can contain dot characters and such names
are not allowed to be used in SAEAUT SNMP OPC Server™ | when transfering in the database all the
dots characters in the names are replaced by underline characters.

User can add specified items into SAEAUT SNMP OPC Server™ configuration one by one or a group
of them at once by selecting wished item or folder in the tree view and clicking Tranfer object(s) to
configuration button. When choosing the folder, all the subfolders and items are added into
configurator database keeping the structure created by browsing.

Description of dialog controls
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3.2

Control Name

Control Type

Description

Load MIB (On-Line) Button The button shows the open dialog
for choosing of a MIB file. After
selecting the MIB file and clicking on
the open button, all defined device
MIB Objects from MIB file will be
loaded.

Transfer object(s) to configuration ~ Button Transfering MIB object (s) to
configuration database of SAEAUT
SNMP OPC Server™ . It is possible
to choose a single item or multiple
items at once. When choosing the
folder, all the subfolders and items
are added into configurator
database keeping the structure
created by browsing.

Close Button Close dialog.

Name static-box (Read-only) Symbolic device name.

Community static-box (Read-only) SNMP community name to which
belongs items.

IP address static-box (Read-only) IP Address of Device.

MIB path static-box (Read-only) The full path to a MIB file which is
loaded.

OID static-box (Read-only) Identifier of MIB Object.

Syntax static-box (Read-only) Syntax of MIB Object.

Derived static-box (Read-only) Specific syntax of MIB Object. The
specific syntax will be converted to
type in the field "Syntax".

Value static-box (Read-only) Value of MIB Object.

Access static-box (Read-only) Access rights of MIB Object.

Status static-box (Read-only) Status of MIB Object.

Description static-box (Read-only) Description of MIB Object.

Related articles

MIB Browser (On-Line) - browsing SNMP variables from a connected Device

How to browse available SNMP variables?

How to verify whether your SNMP device is available? How to use
GET, SET operations from the server configurator?

The SAEAUT SNMP OPC Server™ Configurator was enhanced about the possibility to retrieve (GET
operation) or set (SET operation) a value of SNMP object even in the time of configuration creation.
Both operations are executed ON-LINE directly on an available device without using of OPC interface.

It means, this functionality brings possiblity to test a pure SNMP communication. The operations GET
and SET enable also to verify important information if a device is available or if a data item is available.

The SAEAUT SNMP OPC Server™ implements two following SNMP operations in the configurator:

e The GET operation retrieves a value from a SNMP device. This operation retrieves a value of a
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SNMP object (associated by Object ID).

e The SET operation sets a new value in a SNMP device. This operation sets a new value of a
SNMP object (associated by Object ID).

The mentioned functionality is implemented in the Data Item dialog. More details are available in the
associated sub-topics.
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pure SNMF communication. —

Related articles
The GET operation retrieves a value from a SNMP device.
The SET operation sets a new value in a SNMP device.

3.2.1 The GET operation retrieves a value from a SNMP device.

The GET operation retrieves the current value of a SNMP object (associated by Object ID). The value

is retrieved ON-LINE from a connected SNMP device. To start this opeation please click on the Get
button.
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SHMP value
Hardware: %86 Family 15 Model 47 Stepping 2 AT AT COMPATIBLE - Software; windc

|

The GET operation refrieves a value
from a SNMP device.

Figure: SNMP value is retrieved ON-LINE from device.

The obtained value is presented in scroll-able field. Information that GET operation was successful is

presented by the following dialog:

SAEAUT SNMP Opc Server Configurator rz|

| ) & SHMP walue was retrieved sucessfully,

In the case, that GET opearion failed, it is presented by one of following dialogs:

1. The SNMP device is unavailable. In this case, please verify or change the IP Address of the
SNMP device.

SAEAUT SHMP Opc Server Configurator

@ The device is unavailable, Please verify that the IP Address is correct,

2. The SNMP object with associated Object ID is unavailable. In this case, please verify or change
the SNMP item associated Object ID.
SAEAUT SNMP Opc Server Configurator X

@ The SMMP object is unavailable, Please verify that the Object ID is correct,

Related articles
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How to verify whether your SNMP device is available? How to use GET, SET operations from the se
rver configurator?
The SET operation sets a new value in a SNMP device.

3.2.2 The SET operation sets a new value in a SNMP device.

The SET operation sets a new value of a SNMP object (associated by Object ID). The value is set ON-
LINE to a connected SNMP device. To start this opeation please click on the Set button.

SHMP walue
SAE-PC2

[ Get ] [ Set ]

The SET operation sets avalue in a
SNMP device.

Figure: SNMP value is retrieved ON-LINE from device.

After it, the SNMP SET dialog is shown (see picture below). To set a new value (e.g. SAE-PC1), fill the
Value field and click on the OK button.

[aka ikern

Marne: | swshlame_0

Data bype: | Ocket Skring

|
Object ID: |.1.3.5.1.2.1.1.5.n |
|
|

Walue: | SAE-PC1

Information that SET operation was successful is presented by the following dialog:

SAEAUT SNMP Opc Server Configurator rz|

| ) & neww SHMP value was selt successfully.,
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In addition, it is possible to use the GET operation to verify that your new value was set.

In the case, that SET opearion failed, it is presented by one of following dialogs:

1. The SNMP device is unavailable. In this case, please verify or change the IP Address of the
SNMP device.

SAEAUT SHMP Opc Server Configurator

@ The device is unavailable, Please verify that the IP Address is correct,

2. The SNMP object with associated Object ID is unavailable. In this case, please verify or change
the SNMP item associated Object ID.

SAEAUT SNMP Opc Server, Configurator,

@ Incorrect function, Please werify the following options;

1.1 The SMMP object is unavailable, Please verify that the Object ID is correct,
2.3 The SMMP object is only Read-Cnly,

Related articles
How to verify whether your SNMP device is available? How to use GET, SET operations from the se
rver configurator?
The GET operation retrieves a value from a SNMP device.

3.3 Howto access SAEAUT SNMP OPC Server data through Internet

The data from SAEAUT SNMP OPC Server™ s possible very elegant way to acces through
Internet. Then, the data may be presented directly in Internet browser (e.g. Internet Explorer). The
snapshot of an example application implemented in this way is shown on figure below.
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Figure: Example of accessing data from SAEAUT SNMP OPC Server via Internet

SAE - Automation, s.r.o. delivers the XmIDaSnmpOpcServerWrapper to make SAEAUT SNMP
OPC Server™ available through from Internet. The used wrapper is implemented as Web Service
and needs for running the Internet Information Services (IIS) server to be installed on the PC. IIS
server is accesible from Control Panel > Administrative Tools = Internet Information Services.

The XmIDaSnmpOpcServerWrapper is possible to install during SAEAUT SNMP OPC Server™
installation as optional item. In addition, that wrapper installation package is located in the application
directoty ..\SAEAUT SNMP OPC Server\XML-DA Wrapper Setup\ and may be installed also
additionally.
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*% Internet Information Services |Z||E|r$__<|

File  Action YWiew Help

- D@ XFHE @

Internet Information Services Marne
- g SAEZS (local computer) DP-DD Code

—-[C1 web Sites 3 bin

= o Default iweb Site [#] opevml.Dal0,5ervice.cs
+ - 11sHelp
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- % amlDasnmpopes | @

Serverhrapper

[ App_Code @ Wieb,config
+-27 bin
+-[_1] aspnet_client
+ I:I images
+-[_] webapplicationl
e e e -

Figure: Internet Information Services

Related articles
How to set the Access Rights for OPC XML-DA Wrapper
SAEAUT SNMP OPC Server available from Internet Explorer
How to use SAEAUT SNMP OPC Client

3.3.1 How to set the Access Rights for OPC XML-DA Wrapper

If a XML-DA client is having problems with accessing the SAEAUT SNMP OPC Server,

then the COM security of your computer might be required to be modified. To do it, please
follow the steps below:

1. Click on start - Control Panel > Administrative Tools > Component Services -
Computers - My Computer.

2. Right-click on the My Computer item and select the Properties item.
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Component Services
@ File  Action  Wiew Window  Help

=l 2 0 [

I:l Console Fook Camputers

=

- @ Camponent Services
+ 'a Compukters ‘E

+ % Event Yiewer (Local)

+ Services (Local)

My Computes

Skop M5 DTC
Refresh all components
Wiew

Properties

Figure A: Component Services, My Computer Properties

3. Click the tab COM Security and click Edit Default button under Access Permissions

group.

My Computer Properties

General | Optianz | Defaudt Froperties
Default Frotocols | MSDTC COM Secunly

Apess Pemissions -
iow may edi who i slowed defaut access lo applcations, row may
also et ks on applications that dateming ther own pemizzons.

Edtlimts, | | Edificdaui,

Launch and Activation Pamissian:

rou may edit who s alowed by defaul to launch applications or
acireate objechs. You may alzo zet limits on apphcations that
dedemmire tsir owin permessions.

Edit Limi... Edi Defaut .

[ ok ][ canca |

Figure B: My Computer Properties

4. You need to set the Local Access and Remote Access for the ASP.NET user.
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Access Permission |E"E|
Diefault Securly |

Group o uzar names:

L i ACP MET Machine Azcounkt [SAE24\ASPHET)

€7 SELF
€7 SvsTEM
Agd. | Remove |
Petmizsions for ASPMET
Idachne Accourl Aillosa Drery
Local Accezs [#] ]
Remale Arcess [#] ]

0K | Cancel |

Figure C: Access Permission

5. If ASP.NET user is not in the user list, click the Add button and make sure that the
location where you search for users is the name of your computer (Locations - "PC

NAME").
Select Lisers or Groups E|E|
Select this object pe:
|Uws,ﬁrau|:ls,u Buit-r zecunty mincipals | I Object Types. .,
From this location:
|SAE24 | [ Loestions..
Entes the ooject names to select [sxamples)
T -

Figure D: My Computer Properties
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Locations
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Figure E: Locations
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6. Then click Advanced = Find Now, choose ASPNET user and add it to the user list.
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From this loc alior
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Figure F: Select Users or Groups

7. OK. The settings for Access Permissions are setted. Now, go back to Step 3 and
adjust the same settings under Launch and Activation Permissions group. Then
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3.3.2

3.4

restart your computer.

Related articles
How to access SAEAUT SNMP OPC Server data through Internet
SAEAUT SNMP OPC Server available from Internet Explorer
How to use SAEAUT SNMP OPC Client

SAEAUT SNMP OPC Server available from Internet Explorer

To explore all available methods supported by SAEAUT SNMP OPC Server™ Web Service type
the URL in the internet browser as follows:
http://localhost/ XmIDaSnmpOpcServerWrapper/Service.asmx

Description: http://node/<virtual directory>/Service.asmx

B(=1E3

@.\;— I |§ hitbps filocalhostsmiDasnmpOpcServerwrapper/Service, asm:x V| 4| % | | P

ff‘ Service Web Service - Microsoft Internet Explorer

File Edit ‘View Favorites Tools  Help

w [ {8 Service Web Service

]_l - B meh v |ikPage v () Took + ?

2

The following operations are supported. For a formal definition, please review the Service Description.
* Browse
* GetProperties
+ GetStatus
+ Read
+ Subscribe
&« SubscriptionCancel
&« SubscriptionPolledRefresh

o Write

I % Local intranet H100% -

Figure: http://localhost/XmIDaSnmpOpcServerWrapper/Service.asmx

|

Related articles
How to access SAEAUT SNMP OPC Server data through Internet
How to set the Access Rights for OPC XML-DA Wrapper
How to use SAEAUT SNMP OPC Client

How to use SAEAUT SNMP OPC DA and XML DA Client

In this example the SAEAUT SNMP OPC Client connects to the SAEAUT SNMP
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OPC Server through OPC XML-DA 1.01 interface (Web Service).

The first start of SAEAUT SNMP OPC Client with simple sample project,
which monitors three system SNMP variables:

1. Click on start = Programs - SAEAUT SNMP OPC Server™ - SAEAUT SNMP
OPC Client > SAEAUT SNMP OPC Client.

2. Select the the URL http://localhost/XmIDaSnmpOpcServerWrapper/Service.asmx.
It is Web Service enabling conecting to SAEAUT SNMP OPC Server.

3. Click on the Connect button. You can use for the same purpose also the toolbar
Connect item or the menu Server - Connect item.

B SAEAUT SNMP OPC Data Access and XML Data Access Client =3
File Server Output Options Help

Ed SRDO EHE @6

j Connect

- ZF %D aSrmplpes | Item 1D J Itern Path | Value | Data Type | Ou.. | Timestamp ] Resuk |
= g=f groupl £ MewDevice mib_2 spstem. sysLlpTrne sysl_lnTrrc 0 SAEAUT SHMP OPC Server 14108 Ulre32 go.. 20030604 09:16:53.279 5_OK
2 NewDevic Bl--- = mit sstam svellescr susDest AEAUT SHME OBC Servier Hardware Siring 0, 2009-06-04 09:14:33.432 5 0K
8 MNewDevic 2 Ney mib_2 system, syshlame, sysMame_| AEAUT SMMP OPC Server  <none: S iring go.. 200906.040%14:39432 S_0OK

3 NewDevic

1= W It /o alhost<imiD &5

£ >

gioup]  Z003-06-04 051421442 Keep alive callback recerred b
groupl 20030604 0% 14:26 443 Keep alive callback received.
groupl  2003-06-04 0%14:31 458 Feep alive callback received.
groupl  2009-06-04 0% 14:36 463 Keep alive callback received

OFC .NET API Sample Diata Access Server unning 4 6 2009 9:16:37

Figure 88: SAEAUT SNMP OPC Data Access and XML Data Access Client.

4. Click on start > Programs > SAEAUT SNMP OPC Server™ - SAEAUT SNMP
OPC Client > SAEAUT SNMP OPC Client.

5. Select the the URL http://localhost/XmIDaSnmpOpcServerWrapper/Service.asmx.
It is Web Service enabling conecting to SAEAUT SNMP OPC Server.

6. Click on the Connect button. (You can use for the same purpose also the toolbar
Connect item or the menu Server - Connect item.)

7. Select the XmIDASnmpOpcServiceWrapper-Service item in the application main
tree and via right-click select the Create Subscription... item.

View Skatus, ..
Edit Options. ..
Disconnect

Browse Ikems...

Create Subscription, ..

Read...
Wirite, .,

Figure 89: Create Subscription menu item.

8. Write a group name (e.g. groupl) and click on the Next button.
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&l Create Subscription

=13

M arne |groupd| [term 1D |

Active v 2 <defaults

IJpdate R ate 1000 El:
K.eep Alive Rate 3
Deadband 3 [

Locale | I_I B

.

Mext » Cancel

Figure 90: Create Subscription dialog (page A).

9. Browse all required items and select them via dbl-click. Then on the Next button.

&l Create Subscription

=13

- E‘ #miD aSnmplpcServetsrapper-Service |tem D |
=] S&EAUT SMMP OPC Server 2 cdefaults
=7 MewDevice
= mib_2
= I:I syztem

=] sysDescr
,@ spzDesc
= sysMame

2 sysMame_0

= swsllpTime

B aslpTime_0

Optiohz... ¢ Back Mext » Dane

Figure 90: Create Subscription dialog (page B).

Copyright © 2004-2013, SAE - Automation, s.r.o. (Ltd.), All rights reserved.



109

SAEAUT SNMP OPC Server™

3.4.1

3.4.2

Create Subscription |'-_||'E|E|
- E D a5SnmplpcServern rapper-S ervice Item ID Item Path |
- SAEAUT SNHF’ OPC Server 2 <default
=3 NEWDE""'CE 2 NewDevice.mib_Z system.sysDescrapsDescr_ SAEAUT SMMP OPC Server
=1 E_Ih—z 2 NewDevice.mib_2 system.sysM ame. spsh arme_0 SAEAIT SMMP OPC Server
= Bystem 2 NewDevice.mib_2 svstem.zysUpTime. sysUpTime_0 SAEAUT SMMP OPC Server
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Figure 90: Create Subscription dialog (page C).

10. In the next page click on Then on the Done button.
11. " CONGRATULATION !l Very good. You have just started SAEAUT SNMP OPC
Server™ via OPC XML-DA 1.01 interface.

Note that: If the item Quality is "Bad" and the item Subquality is "Comm Failure" then please see
the following Installation of the SNMP Service topic.

By clicking on the Disconnect button the server becomes disconnected and thus
unavalaible. The current status of the server is displayed on the status bar of the application
on the left bottom of the window.

Related articles
Connection to SAEAUT SNMP OPC Server through OPC DA 3.0
Connection to SAEAUT SNMP OPC Server through OPC XML-DA 1.01
How to access SAEAUT SNMP OPC Server data through Internet
How to set the access rights for OPC XML-DA Wrapper
SAEAUT SNMP OPC Server available from Internet Explorer

Connection to SAEAUT SNMP OPC Server through OPC XML-DA 1.01

In the topic How to use SAEAUT SNMP OPC Client is example where the SAEAUT
SNMP OPC Client is connected to the SAEAUT SNMP OPC Server through OPC
XML-DA 1.01 interface (Web Service).

Related articles
How to use SAEAUT SNMP OPC Client
Connection to SAEAUT SNMP OPC Server through OPC DA 3.0

Connection to SAEAUT SNMP OPC Server through OPC DA 3.0

In this example the SAEAUT SNMP OPC Client connects to the SAEAUT SNMP
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OPC Server through OPC DA 3.0 interface (DCOM).

The start of SAEAUT SNMP OPC Client with simple sample project,
which monitors three system SNMP variables:

Please repeat steps from the main topic The first start of SAEAUT SNMP OPC Client.
Only diffrence is in the Step 2, whre is necessary to select the second item from combo-
box SAEAutomation.SNMPOpcServerDA.3.

£ SAEAUT SMMP OPC Data Access and XML Data Access Client
File Server Cutplt  Options  Help
E@S2BO0 EE @
Sorver  |OmCRg) e e al = Connect
= 23 SAEAutomation SHMPOpcServerDA S | Iem D | e Pt | valse | Data Type | Quaity | Timestamp [ Resur
« g=fl ol 2 [ De H b - 505 131 3 K
B MewD evice mib_2 system syshl ame sysH ams TSR , : 05 11801 08 ,
B MewDevica mib_2 systam syUpTime sysUpTime_0 1811852 Ulri32 oood 200506405 131300277 S_0K
SAE - Aulomation, £.1.0. SAE - Automalion SHMP DPC Server and SAE - Aulomalion SHMP OPC Server AE The zerver it urning noemally 5 B 0913183

Figure A: SAEAUT SNMP OPC Data Access and XML Data Access Client.

Related articles
How to use SAEAUT SNMP OPC Client
Connection to SAEAUT SNMP OPC Server through OPC XML-DA 1.01

3.5 How to simulate SNMP device functionality on YOUR computer

SAEAUT SNMP Agent version 1.00.00 (FREE) - Solution how to
simulate SNMP devices.

We bring new software product called SAEAUT SNMP Agent version 1.00.00. If you need
to simulate SNMP devices or generate the SNMP Trap messages then this product will be
very useful for you.

To read more details about how to use it you can download special white paper
SAEAUT SNMP Agent - User's Guide.

To install that product go to SAEAUT SNMP OPC Server directory .\SAEAUT SNMP OPC
Server\SAEAUT SNMP Agent Setup\ or download the latest version of product from the
following link http://www.saeautom.sk/download/products/snmpagent/saeaut-snmp-

agent.zip.
3.6 How to work with SNMP TRAPs

Working with SNMP TRAPs is described in following white papers:

SAEAUT SNMP OPC Server receives Trap messages
SAEAUT SNMP Agent

The SAEAUT SNMP Agent can generate traps, if the item StartStopSendTraps (.1.3.6.1.4.1.33.0.3.17)
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is set to 1. User can specify a time limit for sending traps by setting the item TrapsTimeoutMs
(.1.3.6.1.4.1.33.0.3.18). The trap message includes a new value of the following three items:

e TrapCounter (.1.3.6.1.4.1.33.0.2.3),
e IntRandom (.1.3.6.1.4.1.33.0.2.5),
e Gauge32Random (.1.3.6.1.4.1.33.0.2.7).

Settings necessary for working with TRAPSs please see in SAEAUT SNMP Agent.

FAQ

This section is regularly updated on the company web page, please the link:
http://www.saeautom.sk/products/snmpopcserver/fag.htm

1. What SNMP protocols are implemented in SAEAUT SNMP OPC Server?
e SNMPv2c.
e SNMPvL.

2. What OPC interfaces are implemented in SAEAUT SNMP OPC Server?
e OPC Data Access 3.0, 2.05 and 1.0.
e OPC Alarm and Events 1.0.
e OPC XML Data Access 1.01 (Part of installation package is the OPC XML-DA Wrapper which
provides an OPC XML-DA Web Service interface as a front-end to one or more OPC COM DA
2.x and 3.0 servers.)

3. Thefirst start of SAEAUT SNMP OPC Server.
Recommendation: Please read more about this issue in User's Guide topic "The first start of SAEAUT
SNMP OPC Server application”.

4. The first start of SAEAUT SNMP OPC Server passed successfully, but Quality of items is
"Bad" and the item Subquality is "Comm Failure".

Recommendation: It is recommended to download the latest white paper which addresses this issue

from link link http://www.saeautom.sk/download/install_snmp_service.pdf. The white paper is called

Installation & Activation of the SNMP Service and SNMP Trap Service.

5. Writing the value on data item doesn't work. Why?
e Dataitem is read only: Check the rights of data items you are using. Open SAEAUT SNMP
Server Configurator and choose data item. Change the rights to Read/Write.

e Community of the device is read only: Check the rights of the community you are using. When
the device is PC, in administrative tools choose services and SNMP service. Open SNMP
service Properties dialog and choose Security tab. Check Accepted community names and
choose the community you are using. Change the rights to READ WRITE. You can add your
own communities with desired rights and use them when configuring the device.

6. Which communication ports does the SAEAUT SNMP OPC Server exploit?
SNMP communication (between SNMP OPC Server and SNMP device):

e SNMP (UDP 161)

e SNMP Trap (UDP 162)

OPC communication (between SNMP OPC Server and OPC Client):
e OPC (TCP 135)

XML-DA communication (between SNMP OPC Server and XML-DA Client):
e XML-DA (HTTP/SOAP 80)
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Heartbeat communication (between SNMP OPC Server and SNMP device):
e Heartbeat (ICMP Echo (ping) request; ICMP Echo (ping) reply). ICMP is Internet Control
Message Protocol.

Be aware that according to required communication is necessary to permit a port in your
firewalls. Settings of the standard operating system firewall are made automatic during
installation.

7. Which ports are used in the SNMP communication?

SNMP uses the default UDP port 161 for general SNMP messages and UDP port 162 for SNMP trap
messages. If these ports are being used by another protocol or service, you can change the settings by
modifying the local Services file on the agent. The Services file is located in \ %SystemRoot
%\System32\Drivers\Etc

8. The SAEAUT SNMP OPC Server doesn't receive any traps? Why?
Please try to check the Windows Firewall whether the SNMP trap messages use allowed. The SNMP
trap messages use default UDP port 162.

To enable SNMP trap messages in Windows Firewall, please do the following:

1. Click on the Windows Start = Control Panel = Windows Firewall.

2. Inthe Exceptions tab click on Add Port and in the associated dialog fill out the fields as follows:
e Name: SNMP Trap
e Port number: 162
e Select the UDP radio button.

Note that: The SNMP trap messages may be received on another UDP port as well. Please see more
in the next point: Which ports are used in the SNMP communication?

9. How to configure OPC and DCOM?

Please refer to the document Configuring OPC and DCOM for OPC server and client applications from
SAE — Automation, s.r.o. that describes OPC and DCOM settings in detail - available in Windows Start
= SAEAUT SNMP OPC Server = Configuring OPC and DCOM.

10. How to make SAEAUT SNMP OPC Server data available via Internet/Intranet?
Recommendation: Please read more about this issue in User's Guide topics "How to access SAEAUT
SNMP OPC Server data through Internet. " and associated sub-topics.

11. How is it possible to verify that XML-DA wrapper has been installed correctly?
Recommendation: Please type the URL in the internet browser as follows:
http://localhost/XmIDaSnmpOpcServerWrapper/Service.asmx. If the XML-DA wrapper is working
correctly you will see a web service test page which will inform you about all operations which are
supported (it is a standard test page for all ASP.NET web services).

12. If the XML-DA wrapper is installed successfully and working, how should we get the related
web services' WSDL?

Recommendation: If the web service test page is working, just click on "Service Description” link on the

top of the screen to display web service's WSDL or visit the following link

http://localhost/XmIDaSnmpOpcServerWrapper/Service.asmx?WSDL.

13. Why is it not possible to overwrite the data items browsed and added by MIB Browser?
SNMP variables browsed from device do not contain information about access rights of variable and by
default all the items added to configurator by browsing have access rights set to read only to avoid
misusing. Such variables are not possible to overwrite from the client and it is user's task to change
access rights and all desired properties of the data item. Properties of data items including access
rights are possible to change from user interface of configurator. Please read more about this issue in
User's Guide topic "Data Item".
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14. In data item definition: Why does the data item validation fail?

Validation of data item can fail in following cases: device supposed to have SNMP agent with desired
SNMP variable is not connected or is incorrectly defined. Check IP address and community of device.
Or: desired SNMP variable is not a leaf variable of a MIB Tree. Only leaf variables are readable from
the device and valid able. Check the Object ID of the SNMP variable. To be sure about Object ID, you
can browse all the SNMP variables of the device from a specified default Object ID. If you do not wish
to browse all the SNMP variables of the device, specify different default Object ID that is closely to the
desired you are looking for. For example, if you are not sure about OID: .1.3.6.1.2.1.25.3.2.1.3, ifitis a
leaf node, put it into Default OID and press Get button for SNMP request. If it is a branch node, all the
nodes below will be browsed and you can access wished Object ID. See MIB Browse help.

15. Why OPC client cannot read Script items or Data items that use scripting?

Reading of Script items or Data items that use scripting fails when any of the used scripts fails to be
parsed. If any script fails to be parsed, no script is executed for any item. Check the scripts that you
defined in the configurator, if there are no illegal characters or programming errors.

16. When does adding of MIB browser items into configurator throw an error?

If adding of browse items into configurator fails and throws an error, it is usually because items
supposed to be browsed would not be unique in a project file. It happens when attempting to write to
the project file that is not active. Make sure that the project file is set to active and try browsing again.
Please read more about this issue in User's Guide topic "Make Active".

17. How to activate product to full version?

In order to activate your software product to full version you will need to enter a name and the license
key. Please start the product you want to activate and click Enter key when asked about product
registration. You will be presented with a dialog window that shows hardware fingerprint. Please e-mail
us this fingerprint and tell us the Name under which you'd like to activate your product. Based on this
information we will send you back the license key that can be used to activate your product.

18. How to use data type SNMP opaque data type
Please see in the article The Domestication of the Opaque Type for SNMP.

Known issues

1. The http://localhost/XML-DA/SAEAutomation.SNMPOpcServerDA.3.asmx test page is not
available.

Recommendation A: Please make sure that COM Security for ASP.NET is set correctly.

Recommendation B: Please make sure that the SAEAUT SNMP OPC Server is installed on your
computer correctly.

Recommendation C: Please make sure that your Web Service link is written right.

Recommendation D: Please make sure that the Internet Information Services (11S) is started.

Recommendation E: Please make sure that .asmx file extension is registered in IIS server.

Recommendation F: Please make sure that Microsoft .NET Framework 1.1 or higher is installed on
your computer correctly (you can see if NET Framework is installed via Administrative Tools panel). If
so, try to reinstall .NET Framework. You can download it at:
http://www.microsoft.com/downloads/details.aspx?FamilylD=262d25e3-f589-4842-8157-
034d1e7cf3a3&displaylang=en
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2. A MIB file is not possible to load through MIB Browser (Off-Line).

This feature is available only in the version SAEAUT SNMP OPC Server, Professional.

There are various mal-formed MIB files which are used in the SNMP devices all over the world.
Therefore, we cannot warrant that each available MIB file will be parsed and loaded successfully by

MIB Browser (Off-Line).

There is a possibility to contact us and send your existing projects to our company. We can try to
convert these existing projects to new structure.

4. The SAEAUT SNMP OPC Server data are not available via OPC UA COM Wrapper interface .
Please refer to the document Configuring DCOM for using of OPC UA COM Wrapper with OPC
servers from SAE-Automation, Ltd. that describes DCOM settings in detail - available in Windows
Start & SAEAUT SNMP OPC Server = Configuring OPC UA COM Wrapper for SAE products .

You can download the latest version of this white paper from the following link
http://www.saeautom.sk/download/opcuaforsaeproducts.pdf.

5. Disconecting from SNMPRuntime when working with OPC DA and XML DA Client

It is not enough to disconect from SNMP OPC server by running OPC DA and XML DA client. It is
necessary to stop the client. Other way SNMPRuntime.exe process continues to run.

6 Support & Contacts

Support

Telephone: +421/ 42 4450701, 03 (Monday - Friday : 8:00 AM - 17:00 PM)
Fax: +421/ 42 4450702

Email: sae-automation@saeautom.sk

Sales

Email: sales@saeautom.sk

Address

SAE - Automation, s.r.o.
TrenCianska 19, or Gorkeho 487/32
018 51 Nova Dubnica, Slovak republic

http://www.saeautom.sk, mailto:sae-automation@saeautom.sk
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